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GLOSSARY OF RELEVANT TERMS 
 

The analysis was developed in adherence to the following terms and their definitions adapted from the 
U.S. Climate Resilience Toolkit and NFWF.  

Term Definition 

Adaptive capacity The ability of a person or system to adjust to a stressor, take advantage of new 
opportunities, or cope with change. 

Ecosystem services Benefits that humans receive from natural systems. 

Exposure The presence of people, assets, and ecosystems in places where they could be 
adversely affected by hazards. 

Impacts Effects on natural and human systems that result from hazards. Evaluating potential 
impacts is a critical step in assessing vulnerability. 

Natural features Landscape features that are created and evolve over time through the actions of 
physical, biological, geological, and chemical processes operating in nature (Bridges 
et al. 2014).  

Nature-based features Features that may mimic characteristics of natural features, but are created by 
human design, engineering, and construction to provide specific services such as 
coastal risk reduction (Bridges et al. 2014). 

Nature-based solutions Natural, engineered, and hybrid approaches that strategically protect, restore, 
sustainability manage, or mimic ecosystems to conserve or restore ecosystem 
functions and natural processes with the goal of reducing community exposure to 
natural hazards and climate stressors, and enhancing habitat for fish and wildlife. 

Resilience The capacity of a community, business, or natural environment to prevent, 
withstand, respond to, and recover from a disruption. 

Risk The potential total cost if something of value is damaged or lost, considered 
together with the likelihood of that loss occurring. Risk is often evaluated as the 
probability of a hazard occurring multiplied by the consequence that would result if 
it did happen.  

Sensitivity The degree to which a system, population, or resource is or might be affected by 
hazards. 

Threat An event or condition that may cause injury, illness, or death to people or damage to 
assets. 

Vulnerability The propensity or predisposition of assets to be adversely affected by hazards. 
Vulnerability encompasses exposure, sensitivity, potential impacts, and adaptive 
capacity. 

Community Assets Critical infrastructure and facilities important to the character and function of a 
community immediately following a major flood event, including populated areas 
and locations with high social vulnerability. 
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EXECUTIVE SUMMARY 
 

Coastal communities throughout the United States face serious current and future coastal flood-related 
threats that are predicted to intensify over the short and long term. Dynamic processes such as coastal 
erosion, storm surge flooding, and river runoff exacerbate the threat from sea level rise. Coastal storms 
and heavy precipitation events have the potential to devastate both human communities and fish and 
wildlife habitats. As communities prepare, decision-makers need tools and resources that allow for data-
driven decision support to maximize available funding opportunities and other planning needs.  

The Alaska Coastal Resilience Assessment aims to support effective decision-making to help build 
resilience for communities facing flood-related threats. The National Fish and Wildlife Foundation 
(NFWF), in partnership with the National Oceanic and Atmospheric Administration (NOAA), is committed 
to supporting programs and projects that improve resilience by reducing communities’ vulnerability to 
coastal storms, sea level rise, and flooding events by strengthening natural ecosystems and the fish and 
wildlife habitat they provide.  

This Geographic Information System (GIS)-based Coastal Resilience Assessment combines spatial data 
related to land use, protected areas, human community assets, flooding threats, and fish and wildlife 
resources to identify and prioritize Resilience Hubs (see figure below). Resilience Hubs are areas of 
natural, open space or habitat where, if investments are made in habitat conservation or restoration, 
there is potential to provide benefits to fish and wildlife and help build human community resilience to 
flooding threats. 
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The Assessment identified areas throughout Alaska where human community assets are exposed to a 
range of coastal-flood related threats. Importantly, the Assessment only considers a community’s 
exposure to flooding threats and not a community’s vulnerability or risk. In addition, the analysis 
identified terrestrial and aquatic areas important for species of conservation concern and subsistence 
resources. Together, the Assessment revealed natural areas of open space and habitat ideal for the 
implementation of resilience projects that may be capable of supporting both the people and fish and 
wildlife of Alaska. The primary mapping products from the Alaska Assessment are shown below. 

Local community planners, conservation specialists, and others can use the outputs of the Alaska 
Assessment to help make informed decisions about the potential of restoration, conservation, or 
resilience projects to support fish and wildlife while also helping to build human community resilience to 
flooding threats. The Assessment is intended to be used as a screening-level tool designed to help 
identify areas that may be well suited for nature-based solutions and is not intended to identify all 
potential opportunities. The Assessment results are also limited by those data available at the time of 
analysis and by the underlying accuracy and precision of the original data sources; therefore, the 
Assessment may not capture all flood-related threats, community assets, fish and wildlife resources, or 
areas of open space (see Appendix A for a list of important data gaps in Alaska). As with all GIS analyses, 
site-level assessments are required to validate results and develop detailed design and engineering 
plans. 

This Alaska Coastal Resilience Assessment report provides a detailed discussion of the data and methods 
used for the three primary analyses (Community Exposure, Fish and Wildlife, and Resilience Hubs), 
regional results, and case studies. In addition to the results presented in this report, NFWF has 
developed the Coastal Resilience Evaluation and Siting Tool (CREST), an accompanying GIS-based web 
tool that allows users to view, download, and interact with the inputs and results of the Alaska 
Assessment (available at resilientcoasts.org). 

https://resilientcoasts.org/#Home
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Community Exposure Index for the Alaska Coastal Resilience Assessment. Higher values represent areas where 

higher concentrations of community assets are exposed to flooding threats. 

Fish and Wildlife Index for the Alaska Coastal Resilience Assessment. Higher values represent areas where numerous 
species of conservation concern and/or subsistence resources and their habitats are located. 
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Resilience Hubs for the Alaska Coastal Resilience Assessment. Higher values represent areas where resilience 
projects may have the greatest potential to benefit both human communities and wildlife.
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INTRODUCTION 
 

1.1 Alaska 

Alaska is the largest and most northerly state in the United States, featuring large tracts of intact habitat 
over 570,640 square miles of land. In addition to its large land expanse, Alaska claims a 33,904-mile 
coastline that represents 38 percent of all U.S. shorelines (ADFG 2015). Polar, temperate continental, 
and temperate maritime climate zones support 32 ecoregions that vary in geology, topography, habitat, 
and biota (ADFG 2015). With arctic tundra in the north, maritime tundra along the western deltas and 
islands, extensive boreal forests that dominate the interior, and far-ranging temperate rainforests along 
the south central and southeastern coasts, Alaska is home to unique habitats and robust wildlife 
populations. 

The state is sparsely populated with over 733,000 residents, approximately 40 percent of whom live in 
the largest city, Anchorage1. With only 1.3 people per square mile, it is the least densely populated 
state. Nearly 88 percent of Alaska’s large tracts of land are managed by the state or federal government, 
supporting more than half of all designated wilderness areas in the entire nation. Twelve Alaska Native 
regional corporations and over 200 local village corporations hold over 44 million acres of land 
throughout the state (Vynne et al. 2021). Only a small percentage of land is in general private ownership 
(ADFG 2015). 

Supported by relatively undisturbed wilderness, Alaska boasts diverse and healthy habitats that support 
abundant wildlife populations across the state. The designation of 155 Key Biodiversity Areas2 
demonstrates the number of globally significant sites for species conservation that occur across Alaska. 
Throughout the state, these areas provide breeding habitat for 7-12 million shorebirds, support over 100 
million seabirds (ADFG 2015), and bolster healthy and diverse salmon populations that occupy an 
estimated 36,000 kilometers of streams (Vynne et al. 2021). While many species remain abundant, 
Alaska also provides refuge for 30 federally threatened and endangered species, including the wood 
bison, Northern sea otter, polar bear, 12 whale and pinniped species, three seabird and one shorebird 
species, four species of marine reptile, one plant, and six fish species (with multiple runs and Distinct 
Population Segments)3. 

Climate change represents a primary threat to Alaska’s diverse wildlife and habitats. Sea ice, tundra, 
permafrost associated wetlands, and glacially influenced rivers, streams, and fjords all represent priority 
habitat types vulnerable to climate impacts (ADFG 2015). Alaska is warming twice as fast as the rest of 
the U.S., leaving habitats, wildlife, and residents vulnerable to current and future climate impacts 
(Markon et al. 2018). Rising temperatures and changes in precipitation are expected to produce warmer 
and longer summers; shorter and milder winters; increased precipitation; melting or thawing of glaciers, 
cryosphere, and permafrost; rising sea levels; and more severe weather events and stronger storm 
surges (Berman & Schmidt 2019). For instance, since the early 1980s, the extent of arctic sea ice has 
decreased by an annual average of 3.5-4.1 percent per decade (Markon et al. 2018). As protective 

 
1 See 2020 Census for details: https://www.census.gov/library/stories/state-by-state/alaska-population-change-between-
census-decade.html.  
2 Birdlife International (2019) World Database of Key Biodiversity Areas. Gland, Switzerland: IUCN. 
3 For a list of threatened and endangered species in Alaska listed under the U.S. Endangered Species Act, visit the U.S. Fish and 
Wildlife Service Environmental Conservation Online System (https://ecos.fws.gov/ecp/) and NOAA 
(https://www.fisheries.noaa.gov/alaska/endangered-species-conservation/endangered-threatened-and-candidate-species-
alaska). 

https://www.census.gov/library/stories/state-by-state/alaska-population-change-between-census-decade.html
https://www.census.gov/library/stories/state-by-state/alaska-population-change-between-census-decade.html
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landfast sea ice forms later in the season, many coastal communities are left exposed to storm-driven 
waves, flooding, and severe erosion. In many cases, the sea ice that does form can be thin, exposing 
coastlines to significant wave action. Reduced sea ice also negatively impacts myriad marine species, 
including threatened and endangered species and important subsistence resources for Indigenous 
communities (Markon et al. 2018). 

Coastal and riverine flooding represent significant threats among the numerous impacts Alaskan coastal 
communities face due to the rapidly changing climate. Rising sea levels, thawing permafrost, and more 
frequent storm surges and wave action due to reduced sea ice extent, all contribute to coastal and 
riparian erosion that leave coastal communities exposed to flooding (Berman & Schmitt 2019; Lantz et 
al. 2020). As glaciers melt and precipitation patterns change, communities situated along rivers and 
within floodplains are also vulnerable to severe flooding and erosion. These compounding effects can 
cause significant structural damage for communities, in some cases reducing access to critical potable 
water and sewer services. The Fourth National Climate Assessment estimates that 87 percent of Alaska 
Native coastal and riverine communities are affected by flooding and erosion (Markon et al. 2018). Since 
May 2011, there have been 14 flood and storm-related major federally declared disasters in Alaska 
resulting in public assistance funding from FEMA of over $100 million. Flooding and storm-related 
damage affected areas throughout the state, including over $24 million in assistance to Southeast Alaska 
in 2021 alone4. 

Flexible, partnership-driven adaptation planning efforts that integrate traditional knowledge and 
wisdom are critical to help Alaskans understand the threats, needs, and gaps facing their communities 
so they may plan, adapt, and help build local resilience to climate threats (Markon et al. 2018). Several 
recent studies helping communities understand flooding threats include the Statewide Threat 
Assessment (UAF 2019), Alaska State Hazard Mitigation Plan (ADHSEM 2018), the Alaska Chapter of the 
National Climate Assessment (Markon et al. 2018), A Toolbox for Resilience and Adaptation in Coastal 
Arctic Alaska (Pletnikoff et al. 2017), the Coastal Flood Impact Assessment for Alaska Communities 
(Buzard et al. 2021), and efforts to create high resolution flood exposure maps (Lantz et al. 2020), 
among many others. The Alaska Coastal Resilience Assessment intends to build on and complement 
these efforts. 

As Alaskan communities take steps to lower their exposure and plan for a more resilient future, 
resources such as this Coastal Resilience Assessment can equip decision-makers and stakeholders with 
valuable tools and information to help them better plan for future flood and storm events. The Alaska 
Coastal Resilience Assessment provides a framework that considers both fish and wildlife habitat and 
resilience for human communities facing growing flooding threats. By focusing on nature-based 
solutions that utilize natural habitats to reduce flooding threats to communities, this Assessment 
highlights one of numerous strategies needed to help build resilience on Alaska’s rapidly changing 
landscape. 
  

 
4 For a list of federally declared disasters in Alaska, visit FEMA: 

https://www.fema.gov/disaster/declarations?field_dv2_state_territory_tribal_value=AK&field_year_value=All&field_dv2_decla
ration_type_value=DR&field_dv2_incident_type_target_id_selective=All. 

https://www.fema.gov/disaster/declarations?field_dv2_state_territory_tribal_value=AK&field_year_value=All&field_dv2_declaration_type_value=DR&field_dv2_incident_type_target_id_selective=All
https://www.fema.gov/disaster/declarations?field_dv2_state_territory_tribal_value=AK&field_year_value=All&field_dv2_declaration_type_value=DR&field_dv2_incident_type_target_id_selective=All
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1.2 Overview of the Regional Coastal Resilience Assessments 

The National Fish and Wildlife Foundation (NFWF) and the National Oceanic and Atmospheric 
Administration (NOAA) are committed to supporting projects and programs5 that improve resilience by 
reducing communities’ vulnerability to coastal storms, sea level rise, and flooding by strengthening 
natural ecosystems and the fish and wildlife habitat they provide. In response to growing coastal 
flooding threats, NFWF commissioned the University of North Carolina (UNC) Asheville’s National 
Environmental Modeling and Analysis Center (NEMAC) to develop an assessment to identify coastal 
areas that are ideal for the implementation of nature-based solutions that build both human community 
resilience and fish and wildlife habitat. The resulting Regional Coastal Resilience Assessments (referred 
to from here forward as the Regional Assessments or Assessments) aim to identify and rank open space 
areas where targeted investments can implement resilience-building projects before devastating events 
occur and impact surrounding communities. 

The Alaska Coastal Resilience Assessment is part of a broader effort that seeks to evaluate regional 
resilience for all U.S. coastlines. Regional Assessments are already complete for the U.S. Atlantic, Gulf of 
Mexico, and Pacific coastlines, Hawaiʻi, Puerto Rico, the U.S. Virgin Islands, Guam, American Samoa, and 
the Commonwealth of the Northern Mariana Islands. The U.S. Great Lakes Assessment is underway 
(Figure 1). 

 
Figure 1. The geographic extent of the Regional Coastal Resilience Assessments in dark gray and the Alaska 
Assessment in orange. All Regional Assessments will be completed by 2022. Map not shown to scale. 

Strategically implementing resilience projects can increase the ability of surrounding communities and 
habitats to withstand and recover from the impacts of coastal storms and flooding events (Narayan et al. 
2017). Efforts to build resilience begin by determining the exposure of a community’s assets to a hazard 
or threat. The Regional Assessments use a GIS-based approach to model landscape characteristics and 
their potential impacts to identify places throughout the United States where assets are potentially 

 
5 See the National Coastal Resilience Fund: https://www.nfwf.org/programs/national-coastal-resilience-fund.  

https://www.nfwf.org/programs/national-coastal-resilience-fund
https://www.nfwf.org/programs/national-coastal-resilience-fund
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exposed to flood threats. They combine human community assets, flooding threats, and fish and wildlife 
resource spatial data to identify and rank Resilience Hubs. Resilience Hubs are areas of natural, open 
space or habitat where, if investments are made in habitat conservation or restoration, there is 
potential to benefit fish and wildlife species while also helping to build human community resilience to 
flooding threats. 

From a modeling standpoint, the Regional Assessments consist of three separate but interrelated 
analyses: (1) the Community Exposure Index, (2) the Fish and Wildlife Index, and (3) Resilience Hubs 
(Figure 2). These three components make the Regional Assessments unique as they look at resilience 
potential through the lens of both human and fish and wildlife communities. Specifically, the Community 
Exposure Index can guide land use and hazard mitigation planners in identifying potential development 
constraints and improve the understanding of possible risks to critical infrastructure and human 
populations. The Fish and Wildlife Index can inform where important species and habitats occur. The 
Resilience Hubs then identify open spaces and habitats suitable for the implementation of projects 
expected to build communities’ resilience to flood events while also benefiting fish and wildlife. 

 

Figure 2. A conceptual model showing the separate, but interrelated components of the 
Regional Coastal Resilience Assessments.  

While Resilience Hubs are the primary output of the Regional Assessments, each component can be 
used individually or in combination to help community planners, conservation specialists, funding 
applicants, and others make informed decisions about the ability of potential restoration, conservation, 
or resilience projects to achieve dual benefits for both human community resilience and fish and wildlife 
species and habitats. The Assessment is intended to be used as a screening-level tool designed to help 
identify areas that may be well suited for nature-based solutions. As with all GIS analyses, site-level 
assessments are required to validate results and develop detailed design and engineering plans. 
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METHODS 
 

2.1 Introduction 

The foundation of the Regional Coastal Resilience Assessments is based on the coastal vulnerability 
research outlined in Gornitz et al. (1994). In 2011, the New Jersey Office of Coastal Management and 
Department of Environmental Protection adapted that research to assess existing and future hazard 
vulnerabilities on a local scale (NJ-DEP 2011). This research was integral to structuring the inputs and 
methodology of this analysis. 

The Regional Assessments use a Geographic Information System (GIS)-based approach to model 
landscape characteristics and their potential impacts through three primary analyses: (1) the Community 
Exposure Index, (2) the Fish and Wildlife Index, and (3) Resilience Hubs. 

While both the Gornitz et al. (1994) and the New Jersey research (NJ-DEP 2011) focus on determining 
the magnitude of flood hazards on the landscape, the Alaska Assessment focuses on the exposure of 
community assets to flood threats. For example, the Community Exposure Index shows communities as 
highly exposed if they have critical facilities and/or infrastructure that also overlap with numerous 
flooding threats. 

In addition to mapping human community assets and flooding threats across the landscape to 
determine exposure, wildlife resources were also identified. Habitat preferences for species of 
conservation concern, subsistence resources, and other managed species were incorporated into two 
Indices: the Terrestrial Index and the Aquatic Index. Many species are vulnerable to flood-related 
stressors such as sea level rise, storm surge, and coastal habitat loss (Powell et al. 2017; Thorne et al. 
2018; von Holle et al. 2019). For example, flooding can impact water quality, which can have negative 
outcomes for sensitive populations of aquatic species (Georgakakos et al. 2014). Flooding can also upset 
ground-nesting birds and other species vulnerable to coastal inundation. However, neither the 
Community Exposure Index nor the Resilience Hubs are used to assess the exposure of fish and wildlife 
or species to flooding threats and should only be used to help identify areas of highly exposed human 
assets that coincide with areas that feature numerous fish and wildlife assets. 

The overarching goal of the Regional Assessments is to identify Resilience Hubs, which help to identify 
natural, open spaces or habitats suitable for resilience-building conservation or restoration efforts 
capable of generating dual benefits for human communities and fish and wildlife. These Hubs are 
determined first by the identification of undeveloped, natural landscapes or habitat cores, and then by 
the ranked combined averages of the Community Exposure and Fish and Wildlife Indices. The following 
sections describe the methods used in the Alaska Coastal Resilience Assessment. 

2.2 Study Area 

The Alaska Assessment focuses on the coastal region of Alaska, including all islands and nearshore 
marine areas to a 20-meter depth contour. Consistent with other Regional Assessments throughout the 
U.S., the boundary of the Alaska Assessment follows the coastal watersheds designated by the U.S. 
Environmental Protection Agency (EPA), which include those watersheds that drain directly to the ocean 
and are represented at a hydrologic unit code eight scale (HUC-8)2. In addition to including the 
immediate coastline, the study area extends far inland to capture areas that influence or are influenced 
by coastal flood-related threats. The analysis was completed at a 30-meter resolution. 
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Figure 3. The Alaska Coastal Resilience Assessment study area. The 20-meter depth contour is shown in black. 

2.3 Data Collection and Stakeholder Engagement 

The Project Team began data collection efforts by compiling an initial set of publicly available data sets 
from multiple national and regional sources. In addition, the Alaska Assessment relied on significant 
input from local and regional stakeholders to identify and inform the use of additional data sets. 

To help guide the Assessment process, the Project Team established an Advisory Committee consisting 
of eight members representing the Alaska Department of Natural Resources, Alaska Division of 
Community and Regional Affairs, Alaska Department of Fish and Game, Alaska Ocean Observing System, 
University of Alaska Anchorage, NOAA Fisheries, and the U.S. Fish and Wildlife Service. The Advisory 
Committee met regularly with the Project Team to: 

1. Provide guidance to the Project Team at key decision points in the analyses, including 
recommendations on data to be included; 

2. Help identify additional local stakeholders within federal agencies, local and tribal governments, 
universities, non-governmental organizations, and others to provide input into the development 
of the Alaska Assessment; and  

3. Advise on final products and tools, including the effective dissemination of results. 

During the initial development of the Assessment, the Project Team established a Technical Working 
Group consisting of Advisory Committee members and other key stakeholders. In January 2020, the 
Project Team hosted a one-day Technical Working Group meeting in Anchorage to discuss and gain 
feedback on the initial design and methods for the Assessment. In addition to the Advisory Committee 
members, other attendees included representatives from the Denali Commission, Alaska Native Tribal 
Health Consortium, Alaska Ocean Observing System, Alaska Conservation Foundation, Alaska Sea Grant, 
U.S. Geological Survey, U.S. Army Corps of Engineers, and the U.S. Fish and Wildlife Service. 
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Building on initial data collection efforts with input from the Advisory Committee and Technical Working 
Group, the Project Team hosted a virtual workshop to allow local stakeholders to review and provide 
input on preliminary Assessment products. The Virtual Stakeholder Workshop was held over the week of 
October 4, 2021. The Project Team hosted three sessions to introduce the Assessment and discuss 
preliminary results. All participants had access to written materials and an online GIS viewer to facilitate 
the review of draft models and provide comments during and after the workshop. The comment period 
remained open for four weeks following the virtual workshop. 

Over 20 people attended the workshop, representing local, tribal, federal, non-government, and 
academic organizations. For a complete list of all organizations invited to the workshop, see Appendix H. 
Workshop participants helped the Project Team: 

1. Identify geographic features, flooding threats, cultural and socio-economic factors, and 
additional considerations that are unique to the region; 

2. Identify, collect, and appropriately use GIS datasets related to flooding threats, community 
assets, species, and habitats; 

3. Provide references and contact information for additional experts that may be able to 
contribute data or knowledge to the effort; and 

4. Obtain overall buy-in to the Assessment process and solicit ways in which it can be used by local 
stakeholders in Alaska. 

Participants reviewed draft maps and data sources during and after the workshop, providing important 
feedback and recommendations to improve the analyses. Not all suggested data sources could be 
included in the Assessment for various reasons described in Appendix A. 

Following the stakeholder workshop, the Project Team reconvened with the Advisory Committee to 
assess the feedback, comments, and suggestions provided during the workshop and to determine which 
data to incorporate into the revised products. NEMAC then followed up individually with Committee 
members and other key stakeholders to further discuss data and methodology as needed. Results of the 
Alaska Assessment were reviewed by the Advisory Committee and shared with local stakeholders via a 
public webinar. 

2.4 Creating the Community Exposure Index 

The Community Exposure Index was created by combining the Threat Index and Community Asset Index, 
depicting the spatial distribution of the potential exposure of assets to flooding threats (Figure 4). The 
following equation calculates exposure: 

Threat Index × Community Asset Index = Community Exposure Index 

While the methods used to create the Community Exposure Index are generally consistent among all 
Regional Coastal Resilience Assessments, the methods were modified for the Alaska Assessment to 
accommodate differences in data availability, relevant flood-related threats, and human community 
asset density. The following text describes the specific methods used for the Alaska Assessment; a 
complete list of datasets included can be found in Appendix B. 
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Figure 4. Elements of the Threat and Community Asset Indices used to create the Community Exposure Index. 

2.4.1 Threat Index 

Flood-related datasets are used to help communities understand which threats are potentially present 
in their area. While other threats may exist, for the purposes of this analysis only those threats relevant 
to coastal flooding-related impacts in Alaska were included. Threats are defined as datasets that show 
coastal flood, erosion, and severe storm hazards on the landscape. Using an ordinal combination 
method, all inputs were ranked numerically from low to high, representing the risk—not the degree—of 
impact (MacDonald 2007; Gornitz et al. 1994; NJ-DEP 2011). Each ranked input is used to create the 
cumulative Threat Index (Ponce Manangan et al. 2014). The Threat Index is then reclassified into 10 
classes using a percentile distribution. Additional details on those data used to create the Threat Index 
for Alaska can be found in Appendix B.1 and Appendix C. 

Areas of Low Slope 
As a terrain’s slope decreases, more land areas become prone to pooling water that can lead to 
prolonged periods of inundation. This threat input was developed with consideration of the Brunn Rule, 
which states that every foot rise in water can result in a 100-foot loss of sandy beach (NJ-DEP 2011). In 
this case, a one percent or less slope is likely to be inundated with a one-foot rise in water, helping to 
identify low-lying coastal areas that are more susceptible to inundation and changing coastal conditions. 
For the Alaska Assessment, slope was calculated from the Interferometric Synthetic Aperture Radar 
(IFSAR) data. More details about the creation of this input can be found in Appendix C.1. 

Soil Erodibility 
Soil erosion resulting from flooding can drastically alter the landscape and impact human communities. 
To assess the erodibility of soils throughout coastal watersheds, the USDA-NRCS Gridded National Soil 
Survey Geographic Database (gNATSGO) K Factor (kffact) was used, which measures the susceptibility of 
soil particles to detachment by water. Soils high in clay have low K values and thus low soil erodibility 
values in the Assessment because they resist detachment. Conversely, the Assessment assigns high 
erodibility values to soils with high silt content, which are easily detached and capable of producing high 
rates of runoff (Renard et al. 2011). 

While the gNATSGO dataset is available for most of the state of Alaska, these data are relatively coarse 
and may not accurately reflect erosion potential at the community scale. Therefore, the Alaska 
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Assessment utilized results from a recent analysis that assessed the risk of damages from erosion for 
187 rural Alaska communities (UAF 2019). The study, known as the Statewide Threat Assessment or STA, 
placed communities into one of three groups dependent on the immediacy and severity of erosion-
related damages to critical infrastructure, where those in Group 1 face severe and immediate threats. 
The STA data were used in place of the gNATSGO data for each of the 187 rural Alaska communities 
assessed. For those communities under immediate threat from erosion according to the STA (Group 1), 
the Project Team assigned the highest erodibility values to each pixel within the community’s footprint6. 
Similarly, those communities with long-term vulnerability to erosion (STA Group 2) and those with low 
vulnerability to erosion (STA Group 3) were assigned moderate and low soil erodibility values in the 
Alaska Assessment, respectively. More details about the creation of this input can be found in Appendix 
C.2. 

Flood-Prone Areas 
Flood-prone areas were identified for the Alaska Assessment through a combination of the FEMA 

National Risk Index (Coastal and Riverine Flooding Annualized Frequency), USDA-NRCS gNATSGO, and 

the Statewide Threat Assessment (STA). Similar to the soil erodibility input, the STA results (UAF 2019) 

for flooding threats were used to generate flood-prone areas values for each of the 187 community 

footprints assessed. For all other areas within the study area, including those communities not assessed 

by the STA, FEMA and gNATSGO data were used to assess areas potentially prone to flooding. To 

prevent flood-prone areas from appearing in locations with high elevation (alpine environments) where 

flooding is unlikely to occur, the flood-prone input was restricted to elevations less than 20 meters 

above sea level using the state’s high resolution IFSAR data. While areas above 20 meters still receive 

values for other inputs included in the Threat Index, the elevation threshold applied to the flood-prone 

area input results in lower overall Threat Index values in higher elevation areas. More details about the 

creation of this input can be found in Appendix C.3. 

Permafrost Thaw 
Permafrost can be found in over 80 percent of Alaska and is structurally important to the soils. Thawing 
of these soils can cause ground subsidence and erosion, both of which can lead to flooding in coastal 
areas. For the Alaska Assessment, a geohazard risk index due to permafrost thaw was used as a direct 
indicator of permafrost-related flooding threat (Hjort et al. 2020). Although those data presented in 
Hjort et al. (2019) cover the entire study area of the Alaska Assessment, where available, the STA results 
(UAF 2019) were used for the permafrost input in a similar manner to the soil erodibility and flood-
prone area inputs. Of the 187 communities assessed by the STA, those with high, moderate, and low risk 
of damage from permafrost thaw were assigned high, moderate, and low values for the permafrost 
thaw input in the Alaska Assessment, respectively. More details about the creation of this input can be 
found in Appendix C.4. 

Tsunami Inundation 
Coastal areas of Alaska are subject to severe tsunami risks. Historically, tsunamis generated by 
earthquakes in Alaska have caused damage and loss of life along the West Coast and across the Pacific. 
Tsunamis generated by nearby earthquakes represent “near-field” hazards. In other words, people have 
minutes rather than hours to reach safety. The Tsunami Inundation Mapping Program, a collaboration 
between the Alaska Earthquake Center and the Alaska Division of Homeland Security and Emergency 

 
6 Community footprints represent boundaries for incorporated cities, Census Designated Places, and Census Blocks according to 

the Local Boundary Commission. Alaska Department of Commerce, Community and Economic Development, Division of 
Community and Regional Affairs. Community Transportation Overview. See the State of Alaska Open Data Geoportal: 
https://gis.data.alaska.gov/datasets/4cbaa40cacfc48ec902ad52095fc370b_0/about. 

https://gis.data.alaska.gov/datasets/4cbaa40cacfc48ec902ad52095fc370b_0/about
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Management, works to make coastal communities safer by providing state and local officials with the 
best possible information for addressing the tsunami hazards faced by their communities. Communities 
are selected with consideration of their tsunami hazard exposure, location, infrastructure, availability of 
data, and willingness to incorporate the results in a comprehensive mitigation plan. Final maps 
incorporate the best tsunami science available at the time of publication. More details about the 
creation of this input can be found in Appendix C.5. 

2.4.2 Community Asset Index 

The Community Asset Index identifies human community assets that are important to help a community 
respond to and recover from a flooding event. The Index used datasets that quantify the number of 
assets present—not their magnitude of vulnerability or susceptibility to flood threats. 

In Alaska, the Community Asset Index included social vulnerability, critical infrastructure, critical 
facilities, and critical transportation infrastructure. All facilities and infrastructure were counted with 
equal weight in the Assessment, highlighting the importance of all community assets, particularly within 
remote villages. This approach is consistent with other existing methodologies to identify community 
assets that support recovery during an emergency, such as the FEMA Community Lifelines framework7. 
As with the Threat Index, the Community Asset Index was ultimately reclassified into 10 classes using a 
percentile distribution. A detailed list of datasets used for all Community Asset Index inputs included in 
the Alaska Assessment can be found in Appendix B.2. See Appendix D for a description of methods used 
to create the Community Asset Index. 

Social Vulnerability 
The social vulnerability input is meant to identify areas in a community where an individual’s ability to 
respond to and cope with the effects of threats might be more or less difficult as compared to other 
areas in the same area. Disadvantaged households are typically found in areas of higher risk, leaving 
them vulnerable to flooding, disease, and other chronic stressors (EPA 2021). For the Alaska 
Assessment, the Denali Commission (2020) annual Distressed Communities report was used to identify 
socially vulnerable communities, each of which received a single value across their entire community 
footprint boundary. The Assessment also used the Demographic Index in EJSCREEN to determine social 
vulnerability, which is the average of the percentage of the population that is low-income and the 
percentage of the population that is minority in each census block group (EPA 2016). More details about 
the creation of this input can be found in Appendix D.1. 

Critical Infrastructure 
The Alaska Assessment included critical infrastructure types that may help communities immediately 
recover from devastating flood events. The types of critical infrastructure used in the Assessment 
included wastewater treatment facilities, power plants/substations, major dams, petroleum refineries, 
hazardous sites, water distribution infrastructure, communication infrastructure, bulk fuel storage, and 
others. More details about the creation of this input can be found in Appendix D.2. 

Critical Facilities 
Critical facilities used in the Alaska Assessment included schools, medical facilities, post offices, and fire 
and police stations identified using the USGS National Structures Dataset. Local data were used in place 
of the National Structures Dataset whenever possible. It is important to emphasize that these critical 
facilities provide important services that support the operation of other types of critical infrastructure, 
such as residential, commercial, industrial, and public properties. These facilities are often prioritized in 

 
7 FEMA Community Lifeline: https://www.fema.gov/emergency-managers/practitioners/lifelines.  

https://www.fema.gov/emergency-managers/practitioners/lifelines
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disaster planning since they may offer refuge to vulnerable populations. More details about the creation 
of this input can be found in Appendix D.3. 

Critical Transportation Infrastructure 
In Alaska, transportation infrastructure is quite different than in other regions of the U.S. The road 
network is relatively small, and many communities, including the state capital, cannot be reached via 
roads. This means that reliance on air and/or water transportation infrastructure is critical for access to 
commodities, evacuation, and emergency response. Data for roads, rail, airports and runways, ferry 
terminals, ports, and harbors were included as a separate input. More details about the creation of this 
input can be found in Appendix D.4. 

2.4.3 Community Exposure Index 

To create the Community Exposure Index, the Threat and Community Asset Indices were each given a 
value of 1 to 10 to indicate a low-to-high presence of threats or assets, respectively. Combination 
methods traditionally result in the summation of inputs to create a final land suitability index; however, 
the Alaska Assessment aims to understand exposure—the relationship between potential threats and 
the presence of community assets. Therefore, a multiplication function was used to understand this 
relationship. Areas with the highest prevalence of threats and the highest presence of community assets 
were calculated as having the highest levels of exposure. See Appendix E for a description of the 
methodology used to calculate the Community Exposure Index. 

2.5 Creating the Fish and Wildlife Index 

The Fish and Wildlife Index, which consists of terrestrial and aquatic components, allows for a greater 
understanding of important habitats and fish and wildlife resources to help identify areas where 
implementing nature-based solutions may support coastal resilience and ecosystem benefits (Figure 5). 
The Index attempts to identify areas on the landscape where terrestrial, aquatic, and marine species of 
conservation concern and their habitats are located. For the Alaska Assessment, only those species of 
concern with federal- or state-level protection status, species of greatest conservation concern, 
important subsistence resources, and/or those species included in resource management plans were 
considered. A complete list of data can be found in Appendix B and a description of the methods used to 
create the Fish and Wildlife Index can be found in Appendix F. 
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Figure 5. Elements of the Terrestrial and Aquatic Indices used to create the Fish and Wildlife Index. 

2.5.1 Terrestrial Index 

The Terrestrial Index aims to identify suitable habitats for species of conservation concern and 
subsistence use. Unlike approaches that rely on uneven species occurrence data, a habitat suitability 
approach provides the opportunity to model groups of species at a consistent regional scale (Rondini et 
al. 2011). To develop habitat suitability models, the Assessment first identified the habitat preferences 
and needs of terrestrial wildlife species of greatest conservation need according to the Alaska State 
Wildlife Action Plan (ADFG 2015), species listed as threatened or endangered under the U.S. Endangered 
Species Act, and important subsistence resources as identified by harvest records maintained by the 
Joint Board of Fisheries and Game8. All species included in the Assessment were then grouped into 
broad taxonomic groupings, including seabirds, land birds, amphibians, and terrestrial mammals. Finally, 
using the Alaska Gap Analysis Project (Gotthardt et al. 2014), IUCN Habitat Classification Scheme9, and 
other habitat-related datasets, habitat preferences were identified for each taxonomic group. Some 
species were excluded from the analysis if there were insufficient data to determine habitat 
preferences. Based on those habitat preferences, three levels of habitat suitability were modeled 
following methods outlined by Rondini et al. (2011). 

1. Primary habitat represents preferred habitat where the species is known to occur. Using these 
guidelines, all designated critical habitat for species listed under the Endangered Species Act, as 
well as habitats identified as important for threatened and endangered species, was considered 
primary habitat for that species’ taxonomic group. 

2. Secondary habitat represents areas where the species can be found but would be unlikely to 
persist in the absence of primary habitat. Secondary habitat also coincides with protected areas 
that are managed for biodiversity, potentially increasing the probability of species utilization. 

 
8 Alaska Department of Fish and Game. Subsistence Harvests: Non-Fishing Resources. 

https://gis.data.alaska.gov/datasets/DCCED::subsistence-harvests-non-fishing-resources/about. 
9 IUCN Habitat Classification Scheme, Version 3.1 available at: https://www.iucnredlist.org/resources/habitat-classification-

scheme.  
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3. Tertiary habitat includes areas that meet the preferences of the taxonomic group and spatially 
proximate to either primary or secondary habitat, meaning the species may utilize that habitat 
patch, but is unlikely to thrive in that habitat alone. 

In addition to modeling habitat suitability, the Index also included BirdLife International Important Bird 
Areas (IBAs), which help to identify areas that support habitat conservation through acquisitions or 
easements or by encouraging the voluntary adoption of best management practices. The IBAs are 
combined with habitat suitability to create the Terrestrial Index.  

Together, the analysis modeled areas with high species richness for species of conservation concern and 
subsistence use based on existing distribution data for each species. A complete list of species 
(organized by taxonomic and species group) included in the Alaska Assessment is available in Appendix 
F.1. 

2.5.2 Aquatic Index 

Using similar methods to the Terrestrial Index, the Aquatic Index identifies habitat preferences for 
species of conservation and subsistence concern that utilize riverine, lacustrine, and nearshore marine 
habitats. Calling on data from Alaska’s Anadromous Water Catalog10, Alaska Gap Analysis Project 
(Gotthardt et al. 2014), IUCN Habitat Classification Scheme9, and NOAA’s Essential Fish Habitat (EFH)11, 
the Index uses existing species distribution data for species of high conservation or economic 
importance to identify areas of high species richness. As with the Terrestrial Index, aquatic species 
included in the Assessment are those listed as species of greatest conservation need according to the 
Alaska State Wildlife Action Plan (ADFG 2015), species listed as threatened or endangered under the U.S. 
Endangered Species Act, species with designated EFH under the EFH provisions of the Magnuson-
Stevens Act, and important subsistence species identified from Alaska Department of Fish and Game 
subsistence harvest records12. In addition, the Aquatic Index included nearshore marine habitats 
including surfgrass, eelgrass, rockweed, soft and dark brown kelps, and canopy kelp species13. A 
complete list of species and data sources included in the Aquatic Index is available in Appendix F.3. 

2.5.3 Fish and Wildlife Index 

To identify areas likely to support a high number of priority species and habitats, the Terrestrial and 
Aquatic Indices were summed to create one combined Fish and Wildlife Index. In addition, protected 
and managed areas such as federally managed lands and Alaska Department of Fish and Game Refuges, 
Sanctuaries, Critical Habitat Areas, and other protected areas were added directly to the Fish and 
Wildlife Index because they impact more than a single species group and are neither distinctly aquatic 
nor terrestrial in most cases. By combining the Terrestrial and Aquatic Indices with protected areas, it 
creates a continuous Fish and Wildlife Index that helps to identify areas where implementing a resilience 
or restoration project would likely benefit fish and wildlife communities. See Appendix F.5 for more 
details on the creation of this combined Fish and Wildlife Index. 

 
10 Alaska Department of Fish and Game, Anadromous Waters Catalog: 

https://www.adfg.alaska.gov/sf/SARR/AWC/index.cfm?ADFG=main.home.  
11 NOAA Fisheries Alaska Region Essential Fish Habitat: https://www.fisheries.noaa.gov/alaska/habitat-conservation/essential-
fish-habitat-efh-alaska.  
12 Alaska Department of Fish and Game. Subsistence Harvests: Non-Fishing Resources. 

https://gis.data.alaska.gov/datasets/DCCED::subsistence-harvests-non-fishing-resources/about. 
13 Alaska ShoreZone: https://www.fisheries.noaa.gov/alaska/habitat-conservation/alaska-shorezone.  

https://www.adfg.alaska.gov/sf/SARR/AWC/index.cfm?ADFG=main.home
https://www.fisheries.noaa.gov/alaska/habitat-conservation/essential-fish-habitat-efh-alaska
https://www.fisheries.noaa.gov/alaska/habitat-conservation/essential-fish-habitat-efh-alaska
https://gis.data.alaska.gov/datasets/DCCED::subsistence-harvests-non-fishing-resources/about
https://www.fisheries.noaa.gov/alaska/habitat-conservation/alaska-shorezone
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2.6 Creating the Resilience Hubs 

Resilience Hubs are areas of natural, undeveloped space that attempt to identify places that may be 
suitable for resilience-building conservation or restoration efforts that can help prepare for potential 
adverse impacts to infrastructure and communities, while also improving the habitats of fish and wildlife 
species. Therefore, Resilience Hubs represent open spaces and habitats that have a high potential to 
provide benefits to both human communities and fish and wildlife. Accounting for natural spaces on 
both inland areas and in the nearshore marine environment, Resilience Hubs are formed based upon 
undeveloped landscapes and habitat types to create Habitat Cores (Figure 6). These Habitat Cores are 
then ranked according to the combined average values of the Community Exposure Index and the Fish 
and Wildlife Index. For a detailed description of data sources and methods, see Appendix B.6 and 
Appendix G, respectively). 

2.6.1 Green Infrastructure 

The Green Infrastructure14 analysis used in the Regional Assessments builds upon methodology 
developed by the Green Infrastructure Center for the continental United States (Firehock & Walker 
2019). Since these data were not available for Alaska, NEMAC replicated the analysis to create this 
important layer for the Alaska Assessment. The analysis identifies “intact habitat cores,” or every natural 
area 4 hectares (10 acres) or greater, regardless of ownership or preservation status. The dataset is 
intended to guide local, regional, and community planners in identifying important places to conserve 
prior to planning development projects. The dataset also helps to prioritize which landscapes to protect 
and connect—such as natural systems that mitigate flooding, provide recreational or subsistence 
opportunities, and benefit air and water quality (Firehock & Walker 2019). Habitat cores also represent 
relatively intact habitat that considers fragmenting features that may disrupt the movement of wildlife 
species. Applying these methods to Alaska, the Green Infrastructure analysis resulted in the creation of 
Habitat Cores (Figure 6), which encompass terrestrial, marine, and freshwater aquatic habitats. Due to 
Alaska’s large tracts of undeveloped land with few fragmenting features, many Habitat Cores are divided 
by HUC-12 watershed boundaries. See Appendix G.1 for details. 

Since the Assessment aims to identify areas where nature-based solutions have potential to benefit both 
fish and wildlife and human communities, the analysis only considered Habitat Cores proximate to 
human community assets. Therefore, a 5-kilometer (3.1-mile) buffer was applied to all assets identified 
in the Community Asset Index. Second, those Habitat Cores that did not intersect with the asset buffer 
were removed from the analysis. This ensures that remaining Habitat Cores are either near human 
community assets or are within nearby HUC-12 watersheds. See Appendix G.2 for details. 

 
14 Note that Green Infrastructure analysis—as it is referred to in this Assessment—pertains to a specific methodology and is not 

intended to represent other local planning and management projects. 
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Figure 6. Unranked Habitat Cores generated from the Green Infrastructure analysis with the addition of riparian 

corridors in Anchorage.  

2.6.2 Addition of Riparian Corridors and Shorelines 

When preparing the Habitat Cores, many narrow shorelines and riparian corridors are excluded from the 
analysis due to the size minimums and other topographical characteristics that are considered in the 
Green Infrastructure methodology. This is particularly pronounced in urban areas where riparian 
corridors along small rivers and streams are excluded despite their potential for stream connectivity and 
urban restoration projects. Similarly, narrow beach and dune systems that represent important 
opportunities to implement nature-based solutions were excluded through the Green Infrastructure 
methodology. Therefore, the National Hydrology Dataset (NHD) “flowlines” feature class was used to 
identify riparian and shoreline Habitat Cores that would have otherwise been excluded from the 
analysis. The NHD flowlines were used to identify streams and rivers within Alaska’s most populated 
incorporated places and U.S. Census Designated Places (parts of greater Anchorage area and Juneau, see 
Figure 6), and to identify all coastlines within a 5-kilometer (3.1-mile) buffer of any community asset. In 
all cases, coastal and riverine flowlines were buffered by 100 meters and combined with the Habitat 
Cores generated through methods described in Section 2.6.1. See Appendix G.3 for details. 

2.6.3 Creating a Hexagonal Grid 

Once the Habitat Cores derived from the Green Infrastructure methodology are combined with the 
riparian and shoreline Habitat Cores, all features were converted into a finer 4-hectare (10-acre) 
hexagonal grid (Figure 7). Due to the limited number of fragmenting features, many Habitat Cores can 
be thousands of acres in size. Therefore, a finer-scale hexagonal grid is important to show variation 
within a given Habitat Core and can help to facilitate local decision-making commensurate with the size 
of potential nature-based projects and solutions. See Appendix G.4 for details. 
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Figure 7. Unranked fine scale 4-hectare (10-acre) hexagonal grid in Anchorage. 

2.6.4 Ranking Resilience Hubs  

As a final step, both the Habitat Cores and hexagonal grid are scored using the average values of the 
Community Exposure and Fish and Wildlife Indices to create ranked Resilience Hubs. As the final product 
of the Assessment, the Resilience Hubs identify areas of open space where implementing a nature-
based solution has potential to benefit fish and wildlife while building community resilience to flooding 
threats. Resilience Hubs are presented in two ways: 1) Resilience Hub Cores provide a coarse-scale view 
that assigns a single average rank to each Habitat Core, and 2) a Resilience Hub Grid provides a fine-
scale view that assigns an average rank to each individual 4-hectare (10-acre) hexagon. 

The Resilience Hub Cores and Grid are both scored using the same methods. Using a zonal statistics 
geoprocessing technique common to many GIS analyses, average values from the Community Exposure 
Index were calculated for each Habitat Core or hexagon, including the surrounding areas within one 
kilometer. Incorporating the buffer area was necessary because Habitat Cores and associated hexagons 
are natural, open landscapes containing few to no exposed community assets. The buffer was 
determined in consultation with technical experts. Next, the average Fish and Wildlife Index value was 
calculated for each Core and hexagon without applying a buffer. The average Community Exposure and 
Fish and Wildlife Index values were then multiplied to produce a score for each Core and hexagon. 

Using a geometric interval distribution, the values for the scored Habitat Cores were then classified into 
a 10-class ranking scale; the scored hexagons were classified into a 10-class ranking scale separately. 
This 1 to 10 ranking, results in the final Resilience Hubs presented as Resilience Hub Cores and a 
Resilience Hub Grid. See Appendix G.5 for details. 

When considering the Resilience Hubs that result from the Alaska Assessment, the following will 
generally be true:  
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(1) Hubs that are not near significant densities of exposed assets will receive lower average 
Community Exposure Index values, whereas those near more exposed assets will receive higher 
values;  

(2) Hubs containing fewer fish and wildlife assets will receive lower average Fish and Wildlife Index 
values, whereas those near more fish and wildlife assets will receive higher fish and wildlife values; 
and  

(3) Hubs with the highest Community Exposure Index and Fish and Wildlife Index values will receive 
a higher ranking. 

In summary, the Resilience Hub approach—in determining both Habitat Cores and their subsequent 
hexagons—identifies contiguous natural landscapes composed of similar landscape characteristics that 
are nearest to community assets. Lands identified have the potential to be of higher ecological integrity 
and thus may offer improved potential for both human and wildlife benefit. This allows for a more 
accurate determination of the boundaries of natural landscapes when forming and ranking the 
Resilience Hubs.  
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RESULTS 
 

The Alaska Coastal Resilience Assessment reveals abundant opportunities to use nature-based solutions 
to help build human community resilience while supporting fish and wildlife habitats and species. 
Nature-based solutions include actions that sustainably manage and utilize natural systems to address 
societal challenges such as flooding and erosion while benefiting biodiversity and human well-being. 
Implementing nature-based solutions, such as habitat restoration and conservation, can provide 
tremendous co-benefits to people and wildlife as described in the case studies outlined below (see 
Section 4). To explore the findings of the Alaska Assessment, results for the Community Exposure Index, 
Fish and Wildlife Index, and Resilience Hubs are presented across five different regions of Alaska: 
Southeast, Southcentral, the Alaska Peninsula and Aleutian Islands, Western Alaska, and Northern 
Alaska. A single model was used for the entire state, allowing results to be directly compared within and 
among regions. 

3.1 Community Exposure Index 

Facing imminent climate threats, Alaska’s vast coastal and riverine shorelines are highly exposed to a 
variety of flood-related threats. Rising temperatures are contributing to widespread permafrost 
degradation and sea ice loss, leaving communities susceptible to damage from increasingly severe 
storms, erosion, and flooding. Despite these threats being well known, statewide spatial data describing 
sea level rise, storm surge, sea ice extent, and other important hazards are limited (Appendix A). By only 
utilizing those data that are available throughout the study area, the Assessment presents a 
conservative estimate of the severity and extent of coastal hazards throughout the state.  

While limited, those data that are available highlight the severity and extent of coastal hazards 
throughout the state. This is evident in the results of the Alaska Assessment, where the Community 
Exposure Index reveals large areas of high exposure as indicated by the darkest shades of brown (Figure 
8c). Exposure values are highest in areas where human community assets (Figure 8b) occur in areas 
facing numerous flooding threats (Figure 8a), which is particularly evident in the vast low-lying wetlands 
and arctic tundra habitats that dominate Western and Northern Alaska. In the sparsely developed 
landscapes of Alaska it is unsurprising that only a small proportion (0.01 percent) of the study area 
received the highest exposure ranking (10); however, the vast majority of communities within the 
Assessment are highly exposed, with an average value between 6 and 10 in the Community Exposure 
Index. 

The results from the Community Exposure Index reveal regional differences in the density of community 
assets and prevalence of flood-related threats. For instance, Southeast and Southcentral Alaska include 
some of the most populated areas in the state, revealing high Community Asset Index values within 
developed areas that include numerous critical facilities connected by an extensive road network, ports, 
bridges, and other types of critical infrastructure (Figures 9 and 10). Many of the community assets in 
these regions occur in low-lying areas that are also subject to numerous flooding threats, leaving areas 
of high exposure largely restricted to the coast and large lakes. There is frequently a sharp divide 
between high and low exposure values driven by steep mountainous terrain that serve to eliminate 
most coastal flooding threats as elevation increases. As expected, some of the highest exposure values 
occur in and around Anchorage, which is home to almost half of Alaska’s residents. Throughout much of 
Cook Inlet, low-lying and flood-prone areas coincide with community assets (Figure 10). Similarly, 
populated areas in Southeast Alaska such as Sitka, Ketchikan, Wrangell, and the capital city of Juneau all 
reveal exposed assets (Figure 9). 
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Figure 8. (a) Threat Index, (b) Community Asset Index, and (c) Community Exposure Index values for the Alaska 
Coastal Resilience Assessment study area. The Threat and Community Asset Indices are multiplied to produce the 
Community Exposure Index, which shows areas where assets overlap flood threats. To view results in detail, see 
CREST. 
  

https://resilientcoasts.org/#Home
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Figure 9. (a) Threat Index, (b) Community Asset Index, and (c) Community Exposure Index values for Southeastern 
Alaska. To view results in detail, see CREST. 

In Southwestern Alaska (Figure 11), exposure values remain low along the high elevation Aleutian Range 
that is largely dominated by undeveloped public lands. In contrast, the lower elevation areas of the 
Alaska Peninsula bordering Bristol Bay reveal very high exposure, particularly around the villages of 
Egegik, Pilot Point, Port Heiden, and Nelson Lagoon, all of which were identified as vulnerable by other 
studies (UAF 2019). On Kodiak Island and throughout the Aleutian Islands, exposure values are largely 
restricted to populated areas such as Kodiak, Unalaska, Akutan, and Nikolski. In other cases, such as 
Umnak Island, the entire island has a high community asset value because the officially designated 
community footprint15 covers the entire island. 

  

 
15 Community footprints represent boundaries for incorporated cities, Census Designated Places, and Census Blocks according 

to the Local Boundary Commission. Alaska Department of Commerce, Community and Economic Development, Division of 
Community and Regional Affairs. Community Transportation Overview. See the State of Alaska Open Data Geoportal: 
https://gis.data.alaska.gov/datasets/4cbaa40cacfc48ec902ad52095fc370b_0/about. 
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Figure 10. (a) Threat Index, (b) Community Asset Index, and (c) Community Exposure Index values for Southcentral 
Alaska. To view results in detail, see CREST. 
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Figure 11. (a) Threat Index, (b) Community Asset Index, and (c) Community Exposure Index values for Southwestern 
Alaska. To view results in detail, see CREST. 

In stark contrast to the other regions, Western and Northern Alaska feature many of the highest 
Community Exposure Index values (Figures 12 and 13). In fact, 71 percent of the highest-ranking 
exposure values across the entire study area occur in extensive low-lying wetlands and arctic tundra 
found in Western and Northern Alaska. The results of the Alaska Assessment relied heavily on estimates 
of flooding, erosion, and permafrost degradation affecting rural Alaska communities (UAF 2019). The 
highest Threat Index values identified in this Assessment occur within community footprint boundaries 
that were classified as highly imperiled across one or a combination of these threats (UAF 2019). The 

https://resilientcoasts.org/#Home
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Community Asset Index further highlights the dozens of remote communities throughout this region, all 
featuring vitally important community assets including schools, emergency services, airports, 
wastewater treatment facilities, bulk fuel storage, and other critical resources. Communities such as 
Shaktoolik, Shishmaref, and Golovin received the highest possible exposure values, highlighting the 
significant and imminent threats Alaska’s rural communities face. Of note, St. Lawrence and Nunivak 
Islands feature high exposure values over the entire land area, owing to their large community 
footprints; by zooming into the villages of Savoonga, Gambell, and Mekoryuk, individual community 
assets become visible (Figure 12). Along the North Slope, the highest exposure values are evident in 
Wainwright, Utqiaġvik, Nuiqsut, and along the Dalton Highway (Figure 13). In contrast, exposure values 
decrease in the western section of the Noatak National Preserve and along the northern flank of the 
Brooks Range east to the Canadian border. 

To explore the results of the analysis in more detail for any area of interest throughout the study area, 
visit the Coastal Resilience Evaluation and Siting Tool (CREST) at resilientcoasts.org. For more details 
about CREST, please refer to Section 3.4 below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 12. (a) Threat Index, (b) Community Asset Index, and (c) Community Exposure Index values for Western 
Alaska. To view results in detail, see CREST.  
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Figure 13. (a) Threat Index, (b) Community Asset Index, and (c) Community Exposure Index values for Northern Alaska. 
To view results in detail, see CREST. 
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3.2 Fish and Wildlife Index 

Alaska boasts diverse and robust fish and wildlife populations owing to large tracts of intact habitat that 
spans over 32 distinct ecoregions. Throughout coastal Alaska, habitat types vary considerably, 
contributing to significant variation in species richness. The Fish and Wildlife Index reveals particularly 
high values within productive nearshore marine waters, along large river deltas, and within extensive 
coastal wetland and estuarine systems (Figure 14c). The results from the Fish and Wildlife Index focus on 
terrestrial, aquatic, and marine species of conservation concern as identified by the Alaska State Wildlife 
Action Plan (ADFG 2015) and the U.S. Endangered Species Act. Federally managed fish species with 
designated Essential Fish Habitat and important subsistence resources vital for many residents and 
Alaska Native communities are also considered. (See Appendix F.1 and Appendix F.3 for a full list of all 
species included in the Fish and Wildlife Index.) By assessing habitat preferences across various 
taxonomic groups, the resulting Terrestrial Index (Figure 14a) and Aquatic Index (Figure 14b) each 
identify areas expected to support numerous species, with the highest values (represented by darker 
shades) representing the highest relative species richness. 

Figure 14. (a) Terrestrial Index, (b) Aquatic Index, and (c) Fish and Wildlife Index values for the Alaska Coastal 
Resilience Assessment study area. The Terrestrial and Aquatic Indices are summed to create the Fish and Wildlife 
Index. To view results in detail, see CREST. 
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Due to the variation in habitats and biodiversity among and within ecoregions (ADFG 2015), there is 
significant variation in Fish and Wildlife Index values across the study area. In the temperate rainforests 
and high-altitude mountains of Southeastern Alaska, moderate to high Fish and Wildlife Index values are 
particularly evident along coastal lowlands, estuaries, and broad river deltas (Figure 15). Terrestrial 
Index values in this region are bolstered by relatively high richness among terrestrial mammals, such as 
numerous furbearers and large predators, and several species of amphibians not found in other parts of 
the state (Figure 15a). In addition, several small Important Bird Areas found throughout Southeast 
Alaska highlight the global importance of this region for many species of birds, including marbled 
murrelet (Brachyramphus marmoratus). The Aquatic Index identifies the numerous rivers that cut 
through the region supporting spawning runs of all five species of Pacific salmon (Oncorhynchus spp.) 
and eulachon (Thaleichthys pacificus), all of which provide food for myriad species (Figure 3.8). 
Nearshore marine habitat also supports marine mammals, including sea otters (Enhydra lutris kenyoni) 
that utilize giant kelp (Macrocystis pyrifera) forests and Steller sea lions (Eumetopias jubatus) whose 
rookery on Forrester Island is one of the largest in Alaska. 

Figure 15. (a) Terrestrial Index, (b) Aquatic Index, and (c) Fish and Wildlife Index values for Southeastern Alaska. To 
view results in detail, see CREST. 

https://resilientcoasts.org/#Home
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In Southeastern and Southcentral Alaska, the rugged Chugach and St. Elias Mountains feature relatively 
low diversity and thus very low Fish & Wildlife values (Figures 15 and 16). While relatively few species 
included in the model occur in this region, mountain goats (Oreamnos americanus), Dall sheep (Ovis 
dalli), hoary marmots (Marmota caligata), and ptarmigans populate the alpine tundra, and rivers and 
streams support Dolly Varden (Salvelinus malma), Pacific salmon, and steelhead trout (Oncorhynchus 
mykiss). 

Along the coastal Gulf of Alaska and east of Prince William Sound, the broad coastal plains and large 
river deltas reveal very high Fish and Wildlife values. For instance, the Copper River Delta serves as 
important stopover, nesting, and feeding habitat for migratory shorebirds resulting in high values in the 
Terrestrial Index (Figure 16a). Nearshore marine waters support abundant forage fishes, large steelhead 
trout runs occur in the Situk and Copper Rivers, and Steller sea lions and Pacific harbor seals (Phoca 
vitulina richardii) use haul out areas along the rocky shorelines, all producing high Aquatic Index scores 
over much of coastal Gulf of Alaska (Figure 16b). 

Relatively high values are also seen along the Cook Inlet Basin (Figure 16). While this area is one of the 
most developed in the state, the numerous small lakes, swamps, bogs, large rivers, and the productive 
waters of Cook Inlet, all attract shorebirds and waterfowl, large terrestrial mammals, myriad 
anadromous and resident fishes, and marine mammals, including the endangered beluga whale 
(Delphinapterus leucas) Cook Inlet Distinct Population Segment. 

Kodiak Island and the Gulf coast of the Alaska Peninsula both include high, steep mountain ridges that 
give way to deeply cut fjords. High valley lakes and glacially fed streams on Kodiak Island support 
abundant salmon runs that feed robust populations of Kodiak brown bear (Ursus arctos middendorffi). 
Visible in the Fish and Wildlife Index (Figure 17), the island’s coastal cliffs support large seabird colonies 
of puffins, auklets, and black-legged kittiwake (Rissa tridactyla), among others. 

Along the Alaska Peninsula, the Terrestrial Index highlights the importance of the coastal wetlands, 
lagoons, and protected bays for seasonal waterfowl and large shorebird aggregations (Figure 17a). For 
instance, Izembek and Moffet Lagoons on the Bering Sea side of the Peninsula host more than 500,000 
shorebirds each spring including marbled godwit (Limosa fedoa beringea) and rock sandpiper (Calidris 
ptilocnemis). Izembek Lagoon also features one of the largest eelgrass beds in the world that together 
with large intertidal and subtidal kelp forests on the Gulf coast, provide important habitat for myriad 
marine species (ADFG 2015). 

Throughout the Peninsula and Aleutian Islands, the Aquatic Index (Figure 17b) reveals high values within 
nearshore marine waters, which provide summer feeding grounds for whales, while coastlines offer 
rookeries and haul out areas for Steller sea lion and Pacific harbor seal. Evident in the Terrestrial Index, 
the high cliffs and boulder beaches of the Aleutian chain harbor globally significant seabird colonies 
including red-faced cormorant (Phalacrocorax urile) and fork-tailed storm petrel (Hydrobates furcatus). 
The peninsula and islands also provide wintering habitat for threatened Steller’s eider (Polysticta stelleri) 
and the endemic Aleutian song sparrow (Melospiza melodia sanaka). 
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Figure 16. (a) Terrestrial Index, (b) Aquatic Index, and (c) Fish and Wildlife Index values for Southcentral Alaska. To 
view results in detail, see CREST.  
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Figure 17. (a) Terrestrial Index, (b) Aquatic Index, and (c) Fish and Wildlife Index values for Southwestern Alaska. To 
view results in detail, see CREST.  

https://resilientcoasts.org/#Home
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The subarctic tundra dominating Western Alaska features some of the highest Fish and Wildlife Index 
values across the entire study area (Figure 18). High values are particularly evident in the coastal and 
nearshore marine areas where important habitat for marine mammals and Essential Fish Habitat for 
groundfishes, crabs, and Pacific salmon species overlap with large Important Bird Areas and high species 
richness among seabirds, shorebirds, and waterbirds. Inland, many of the highest Fish and Wildlife 
values occur over coastal lowland habitat and along river valleys. Moose (Alces americanus), caribou 
(Rangifer tarandus), brown bear (Ursus arctos), wolverine (Gulo gulo), arctic fox (Vulpes lagopus), and 
other land mammals are found throughout much of Western Alaska, contributing to high Terrestrial 
Index values (Figure 18a). Extensive wetlands, lakes, and ponds also contribute to higher values due to 
large waterfowl populations, including globally significant populations of black brant (Branta bernicla 
nigricans) along the Yukon-Kuskokwim Delta. Similarly, a wide range of shorebirds utilize coastal littoral 
and wetland areas during spring and fall migrations. Moderately high Fish and Wildlife values are also 
present in the Bering Sea islands, including St. Lawrence, St. Matthew, and the Pribilof Islands, all of 
which contain Important Bird Areas and large seabird breeding colonies. 

Figure 18. (a) Terrestrial Index, (b) Aquatic Index, and (c) Fish and Wildlife Index values for Western Alaska. To view 
results in detail, see CREST. 
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High Aquatic Index values are also visible throughout much of Western Alaska (Figure 18b). Numerous 
species of marine mammals utilize nearshore and coastal habitat for feeding and breeding, including 
beluga, gray, and minke whales that can be found from Bristol Bay to the northern Seward Peninsula. 
Walruses (Odobenus rosmarus), Steller sea lions, polar bears (Ursus maritimus), and numerous seal 
species are found near the coast and along adjacent ice floes. Important pinniped breeding habitat and 
haul out areas are located throughout the region including the Walrus Islands State Game Sanctuary in 
northern Bristol Bay and the Pribilof Islands, which provide critical habitat for Steller sea lion and 
approximately 80 percent of the world’s northern fur seal (Callorhinus ursinus) population. Anadromous 
and resident freshwater fishes are also abundant throughout Western Alaska and visible in the Aquatic 
Index. All five Pacific salmon species are present in the region’s many large streams and rivers including 
significant runs of sockeye (Oncorhynchus nerka) in the Kvichak River and chinook (O. tshawytscha) in 
the Nushagak River. Arctic grayling (Thymallus arcticus), arctic char (Salvelinus alpinus), Dolly Varden, 
northern pike (Esox Lusius), whitefishes, Alaska blackfish (Dallia pectoralis), Bering cisco (Coregonus 
laurettae), and other fishes are also prevalent through the region. 

Northern Alaska’s polar arctic tundra is characterized by a treeless, windswept landscape replete with 
numerous lakes, wetlands, permafrost-related features, and large rivers winding through the wide 
coastal plain. The Fish and Wildlife Index (Figure 19) reveals the highest scores along the low-lying 
coastal plain, which provides nesting habitat for the threatened spectacled eider (Polysticta stelleri) and 
other waterfowl. Over two dozen species of shorebirds utilize breeding habitat including a large 
proportion of the U.S. breeding populations of long-billed dowitcher (Limnodromus scolopaceus), dunlin 
(Calidris alpina), and several sandpiper species. The region is also important for four distinct caribou 
herds, muskoxen (Ovibos moschatus), arctic fox, polar bears, and other land mammals. Moving inland, 
Fish and Wildlife Index values drop into the Brooks Foothills, but the Aquatic Index still identifies large 
rivers, streams, and ponds important for arctic char, lake trout (Salvelinus namaycush), and Dolly Varden 
as well as Pacific salmon in the rivers draining into the Chukchi Sea. 

To explore the results of the analysis in more detail for any area of interest throughout the study area, 
visit the Coastal Resilience Evaluation and Siting Tool (CREST) at resilientcoasts.org. For more details 
about CREST, please refer to Section 3.4 below. 
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Figure 19. (a) Terrestrial Index, (b) Aquatic Index, and (c) Fish and Wildlife Index values for Northern Alaska. To view 
results in detail, see CREST.  

https://resilientcoasts.org/#Home
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3.3 Resilience Hubs 

The Alaska Assessment identified many Resilience Hubs throughout the state. While Western and 
Northern Alaska feature many of the highest-ranking Resilience Hubs, the Assessment revealed ample 
opportunities throughout the study area to implement nature-based solutions that may help build 
human community resilience while also benefiting fish and wildlife habitat and the species and 
ecosystem services they support. 

The final Resilience Hub rankings identify areas of contiguous open space that are of a sufficient size to 
provide fish and wildlife and flood risk reduction benefits. As described in the Methods section above, 
the boundaries of the Resilience Hubs are formed through a Green Infrastructure analysis, which 
identifies Habitat Cores at least 4 hectares (10 acres) in size. Once the boundaries of the Habitat Cores 
are determined, a single average rank is applied based on the product of the Community Exposure and 
Fish and Wildlife Index values. To see additional detail, results are also presented as a Resilience Hub 
Grid, where Habitat Cores are converted into 4-hectare (10-acre) hexagons. Each hexagon also receives 
a single average rank based on the Community Exposure and Fish and Wildlife Index values. 

Resilience Hub results are presented as both coarse-scale Resilience Hub Cores and a fine-scale 
Resilience Hub Grid. When viewing the Resilience Hub Cores, large tracts of contiguous open space are 
helpful to identify connected landscapes, but because each Core receives a single average rank, it can 
obscure variation within the Core. Therefore, the Resilience Hub Grid is helpful to visualize variation, 
where the highest-ranking hexagons will occur in those areas in closest proximity to human community 
assets exposed to flooding threats. In all cases, only the highest-ranking Resilience Hubs represent areas 
with the greatest potential to implement nature-based solutions capable of achieving dual benefits. 

Due to the large scale of the Alaska Assessment, differences between the Resilience Hub Cores and Grid 
are not easily distinguishable at a state or even regional level. Therefore, readers are encouraged to 
view the results in more detail for any area of interest by visiting the Coastal Resilience Evaluation and 
Siting Tool (CREST) at resilientcoasts.org. For more details about CREST, please refer to Section 3.4 
below. As an example of the distinction between the Resilience Hub Cores and Grid, Figure 20 zooms 
into the communities along the Kuskokwim River to provide a side-by-side comparison. The Resilience 
Hub Cores help to visualize connected watersheds and contiguous habitat; however, the rankings are 
based on the average values assigning a single score regardless of the size or features within the Core 
(Figure 20a). By viewing the Resilience Hub Grid, the variation within a given Core becomes visible 
(Figure 20b). For the purposes of this report, the regional results are shown through the Resilience Hub 
Grid only (Figure 21). 

https://resilientcoasts.org/#Home
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Figure 20. (a) Resilience Hub Cores and (b) Resilience Hub Grid along the Kuskokwim River. When viewed at this 
scale, the difference between the Cores and Grid become apparent. To view results in detail for other communities, 

see CREST. 

Figure 21. Resilience Hub Grid for the Alaska Coastal Resilience Assessment study area. High ranking Resilience 
Hubs (darker reds) represent areas well suited for the implementation of nature-based solutions that may benefit 
both species of conservation concern and human community resilience to flooding threats. To view results in detail, 
see CREST. 

https://resilientcoasts.org/#Home
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The analysis revealed large differences in the Resilience Hub rankings between regions. For instance, in 
Southeast and Southcentral Alaska the highest-ranking Resilience Hubs occur within and around the 
most populated areas in the state such as Anchorage, Wasilla, Homer, Yakutat, Juneau, Wrangell, and 
Cordova (Figures 22 and 23). This is driven by a combination of moderate Fish and Wildlife values in 
areas of open space near developed areas. Even within downtown Anchorage where there are relatively 
few large areas of open space, high ranking Resilience Hubs reveal opportunities for stormwater 
management, riparian restoration, and other types of projects well suited for urban environments. 
However, Resilience Hub rankings quickly decrease outside of developed areas, where many very low 
values are visible. The steep terrain found over much of Southeastern and Southcentral Alaska quickly 
dampens impact from coastal flooding threats and thus reduces Resilience Hub values, suggesting these 
alpine environments are poorly suited to nature-based solutions to address flooding threats. 

Figure 22. Resilience Hub Grid for Southeastern Alaska. To view results in detail, see CREST. 

Figure 23. Resilience Hub Grid for Southcentral Alaska. To view results in detail, see CREST. 
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In Southwestern Alaska, the highest-ranking Resilience Hubs occur along Kodiak Island and the Alaska 
Peninsula (Figure 24). This is particularly evident along the northern margin of the Peninsula where rural 
communities along Bristol Bay are highly exposed to flooding threats. The numerous bays and rivers 
provide excellent fish and wildlife habitat and offer ample conservation opportunities to benefit 
Ugashik, Egegik, Port Heiden, and other exposed communities. Habitat Cores here are also somewhat 
smaller, though there are still some large Cores. Community Exposure values are also higher here than 
in other parts of Southwestern Alaska, though Fish and Wildlife values are primarily the highest directly 
along the coast. These patterns validate those seen in the Resilience Hubs. On the southern margin of 
the Alaska Peninsula and throughout the Aleutian Islands, Resilience Hub rankings are relatively low due 
to a combination of low community asset density and moderate Fish and Wildlife Index values. 
However, higher-ranked Hubs around Unalaska, Umnak, Shemya, St. George, and St. Paul Islands reveal 
potential opportunities for nature-based resilience building projects. 

Figure 24. Resilience Hub Grid for Southwestern Alaska. To view results in detail, see CREST. 

Across the entire study area, Western and Northern Alaska contain the highest density of highly ranked 
Resilience Hubs (Figures 25 and 26). Flooding threats extend well inland over extensive low-lying coastal 
wetland and arctic tundra, leaving many rural Alaska communities exposed to severe and imminent 
climate-driven flooding hazards (UAF 2019). Rural communities are surrounded by large expanses of 
undeveloped open space that not only provide important habitat for many species of conservation 
concern and subsistence use, but also provide opportunities for conservation actions that may help 
build community resilience. Along the coast, highly exposed communities such as Hooper Bay, 
Shaktoolik, Nome, Point Hope, Utqiaġvik, and many others are adjacent to, and in some cases 
surrounded by high-ranked Resilience Hubs. Also, values are typically lower among inland communities, 
large rivers reveal high Resilience Hub values far inland surrounding communities such as Bethel, 
Napakiak, and Kwethluk along the Kuskokwim River and Mountain Village and Saint Mary’s along the 
Yukon River. As noted previously, St. Lawrence and Nunivak Islands feature very high Resilience Hub 
values over nearly the entire land area, owing to their large community footprints16. 

 
16 Community footprints represent boundaries for incorporated cities, Census Designated Places, and Census Blocks according 
to the Local Boundary Commission. Alaska Department of Commerce, Community and Economic Development, Division of 
Community and Regional Affairs. Community Transportation Overview. See the State of Alaska Open Data Geoportal: 
https://gis.data.alaska.gov/datasets/4cbaa40cacfc48ec902ad52095fc370b_0/about. 

https://resilientcoasts.org/#Home
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To explore the results of the analysis in more detail for any area of interest throughout the study area, 
visit the Coastal Resilience Evaluation and Siting Tool (CREST) at resilientcoasts.org. For more details 
about CREST, please refer to Section 3.4 below. 

Figure 25. Resilience Hub Grid for Western Alaska. To view results in detail, see CREST. 

https://resilientcoasts.org/#Home
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Figure 26. Resilience Hub Grid for Northern Alaska. To view results in detail, see CREST. 
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3.4 Coastal Resilience Evaluation and Siting Tool 

To provide an online interface to allow users to interact with key Assessment data, including input data 
and final models for the Community Exposure Index, Fish and Wildlife Index, and the Resilience Hubs, 
the Coastal Resilience Evaluation and Siting Tool (CREST) was developed as an accompanying GIS-based 
web tool (available at resilientcoasts.org). CREST helps users make informed decisions about proposed 
project sites and address other key questions about how to build resilience within their community. It 
also allows users full access to the Alaska Assessment data so they may incorporate them into their own 
GIS applications or other planning processes. Additionally, CREST provides access to the Assessment 
results even if the user does not have a GIS background or access to GIS software. 

Users can directly access results of the Alaska Assessment straight from the CREST homepage. In 
addition to simply exploring the results of the Regional Assessments, CREST allows users to analyze 
results for specific areas of interest. For instance, if a user has already identified a potential project 
location, they can draw or upload the project boundary within the tool to view site-specific results for 
the Resilience Hubs, Community Exposure Index, Fish and Wildlife Index, and the results for each of the 
model inputs. Alternatively, if a user does not have a specific project location in mind but is interested in 
evaluating opportunities within a particular region, they can draw a broad area of interest to view 
results. In both cases, the user can view the results in CREST or download the results in tabular or GIS 
formats for additional analysis. 

CREST is intended to be used as a screening-level tool designed to help identify areas that may be well 
suited for nature-based solutions. As with all GIS analyses, site-level assessments are required to 
validate results and develop detailed design and engineering plans. 
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CASE STUDIES 
 

Communities throughout Alaska face significant and imminent threats due to climate change. Recent 
studies suggest at least 144 communities throughout Alaska are threatened by erosion, flooding, 
permafrost degradation, or a combination of all three (UAF 2019). Communities need a wide range of 
strategies and solutions to protect their residents against more frequent and severe coastal flooding 
threats. Nature-based solutions offer one such strategy that can help communities utilize Alaska’s 
abundant natural habitat to provide risk reduction benefits. Nature-based solutions are natural, 
engineered, and hybrid approaches that strategically protect, restore, sustainability manage, or mimic 
ecosystems to conserve or restore ecosystem functions and natural processes with the goal of reducing 
community exposure to natural hazards and climate stressors and enhancing habitat for fish and 
wildlife. For instance, efforts that work to restore coastal marshes, rebuild dunes or natural buffers, or 
installing living shorelines, among other approaches, all are strategies that reduce climate risks to 
communities while enhancing habitats. The Alaska Coastal Resilience Assessment aims to identify 
opportunities to implement nature-based solutions that not only provide habitat and wildlife benefits, 
but also help build community resilience to flooding threats and other coastal hazards. The following 
case studies describe several recent and ongoing projects throughout the state17, using the Alaska 
Assessment to demonstrate how results can be used to identify potential locations to implement or help 
advance nature-based solutions. 

4.1 Protecting Critical Human Community Assets in Shaktoolik 

Shaktoolik is a remote Alaska Native village situated between Norton Sound and over 160,000 acres of 
low-lying coastal wetlands and arctic tundra. Located on a narrow sand and gravel spit, the village is 
imminently threatened by severe storm surges and wave-driven flooding, the effects of which are 
exacerbated by a loss of sea ice throughout Norton Sound. To the east, major precipitation events can 
cause the Shaktoolik and Tagoomenik Rivers to flood and temporarily disconnect the village from the 
mainland. The village’s exposed coastline and cumulative flooding threats mean Shaktoolik is one of the 
most imperiled communities in Alaska (UAF 2019). 

According to a 2019 survey completed by the Native Village of Shaktoolik, 45 percent of Shaktoolik’s 260 
residents have reported flooding and/or storm damage in the past five years. Recent community erosion 
and coastal flooding analyses by the U.S. Army Corps of Engineers revealed that numerous critical 
community assets are not only vulnerable to erosion (USACE 2009), but the entire community is at risk 
of flooding during a 100-year storm event (one percent return period) (USACE 2011). 

For decades, the Native Village of Shaktoolik, the City of Shaktoolik, and the Shaktoolik Native 
Corporation have taken steps to help safeguard the community by constructing protective berms. One 
such berm, situated between the community and Norton Sound is designed to help protect against a 20-
year storm event (five percent return period) (Figure 27). However, a lower magnitude winter storm in 
2019 produced large waves that topped the berm and caused damage to critical infrastructure. Studies 
clearly demonstrate the current berm does not provide sufficient protection against large magnitude 
storms that are expected to increase in frequency under future climate scenarios. 

 
17 The case studies described in this report are meant to be illustrative and are not meant to highlight the types of projects that 

may be competitive for National Coastal Resilience Fund or National Fish and Wildlife Foundation funding. 

https://nfwf-my.sharepoint.com/personal/kristen_byler_nfwf_org/Documents/Desktop/Resilience/Regional%20Coastal%20Resilience%20Assessments/_Assessment%20Regions_/Alaska/Final%20Report/Case%20Study/AK_Case%20Study%20Draft.docx#_msocom_1
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Figure 27. Twenty-year berm adjacent to the Village of Shaktoolik before construction of the new 
berm. This location shows above-average vegetation cover. Photo Credit: Sophia Katchatag, Native 
Village of Shaktoolik. 

In response, the Native Village of Shaktoolik and partners are increasing the width and height of the 
existing berm (Figure 28) to withstand maximum storm-surge water levels for a 50-year storm event 
(two percent return period). With funding from the National Coastal Resilience Fund18 and other 
sources, the berm will be constructed using nature-based and locally sourced materials, offering a cost-
effective and sustainable solution to enhance protection for the village. The Alaska Assessment reveals 
very high levels of exposure in Shaktoolik (Figure 29) driven by numerous and severe flooding and 
erosion-related threats to critical infrastructure assets (Figure 30). The berm will help protect exposed 
assets, including roads, the village school, and other critical infrastructure. Also at risk are the 
community’s water treatment plant, power plant, and fuel tank farm, which if flooded threaten public 
health and the release of contaminants. Traditional gray infrastructure such as a sea wall revetment was 
not feasible due to cost and long-term maintenance requirements and would not offer any habitat 
benefit. Working with a regional engineering firm, project-specific models indicate that a vegetated 
berm will offer sufficient protection during a 50-year storm event potentially saving $10-46 million in 
infrastructure replacement costs. In addition, and unlike traditional gray infrastructure, the natural berm 
can be constructed and maintained by Shaktoolik residents, supporting community engagement and 
local jobs. 

 

 
18 https://www.nfwf.org/programs/national-coastal-resilience-fund 

https://www.nfwf.org/programs/national-coastal-resilience-fund
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Figure 28. Map showing the approximate location of the Shaktoolik berm in yellow. 

Figure 29. The Community Exposure Index results for the village of Shaktoolik reveal very high exposure to flooding 
threats within and surrounding the village. The yellow line outlines the approximate location of the nature-based 
berm. 
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Figure 30. The Community Asset Index shows concentrations of community assets in front of the approximate location 
of the protective berm (yellow line). 

By utilizing natural materials, the berm will also support native vegetation and help restore important 
coastal dune habitat. The project team will plant native beach wildrye (Leymus mollis) on the berm, 
which will help stabilize soils, reduce erosion, and increase vegetated cover between the community 
and Norton Sound by 70 percent. In addition to providing direct habitat benefits, the project team 
estimates that the berm will also help protect community assets and reduce the risk of large-scale 
contamination of hazardous and biological materials to over 50,000 acres of coastal wetlands. Measures 
to prevent contamination during storm events are not only critical for human health, but also help 
protect important habitat for many species including vital subsistence resources.  

Restoration activities will create 1.3 acres of dry graminoid herbaceous upland community that supports 
seabirds and other species. The sprawling wetlands to the east of Shaktoolik provide habitat for 
migratory birds including critical habitat for the federally threatened spectacled eider (Somateria 
fischeri). The Shaktoolik River supports all five Pacific salmon species, Arctic grayling (Thymallus 
arcticus), Dolly Varden (Salvelinus malma), Arctic char (Salvelinus alpinus), and many other freshwater 
fishes designated as species of greatest conservation concern by the State of Alaska (ADFG 2015). The 
productive waters of Norton Sound support Essential Fish Habitat for groundfishes, crabs, and Pacific 
salmon species and are home to numerous protected marine mammals including Pacific walrus 
(Odobenus rosmarus), ribbon seal (Histriophoca fasciata), and the Eastern Bering Sea stock of beluga 
whales (Delphinapterus leucas). The results of the Alaska Assessment highlight the importance of this 
region for both terrestrial and aquatic species (Figure 31). 

With concentrations of coastal community assets and wildlife habitat facing significant flooding and 
erosion threats, the Shaktoolik berm and habitat restoration project demonstrates the potential for 
multiple resilience-building benefits. The village of Shaktoolik is surrounded by Resilience Hubs with the 
highest possible ranking, highlighting the suitability and benefits of implementing nature-based, 
resilience-building interventions (Figure 32). While berms are not always considered nature-based 
solutions in other parts of the country where they can block tidal connectivity, in Alaska’s unique setting 
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with its unique coastal risks, berms constructed from natural materials coupled with habitat restoration 
provides a viable and cost-effective strategy for building coastal resilience for remote villages. 

Figure 31. Fish and Wildlife Index results for the village of Shaktoolik revealed very high values within nearshore 
marine water and the rivers and wetlands to the east of the village. The yellow line outlines the approximate location 
of the nature-based berm. 

Figure 32. Resilience Hubs reveal nearly all areas of open space surrounding the village of Shaktoolik are suitable 
for nature-based resilience projects with potential to benefit fish and wildlife and help build community resilience to 

flooding threats. The Resilience Hub Grid shows 4-hectare (10-acre) hexagons covering areas of open space. The 

yellow line outlines the approximate location of the nature-based berm. 
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4.2 Conserving Habitat in the Kenai Peninsula  

Nature-based solutions are also a viable strategy in the more developed areas of Southeast and 
Southcentral Alaska. For instance, fish passage improvement projects can not only open streams and 
rivers for free passage of important anadromous fishes, but dams and undersized culverts can also 
contribute to flooding risk for roads and nearby human community assets. Within urbanized areas, 
stormwater management offers another viable nature-based solution with potential for shared wildlife 
and flood resilience benefits. While many nature-based solutions rely on engineering and restoration 
techniques, habitat conservation can also be an important component of building community resilience. 

The Kasilof River in the Kenai Peninsula winds through the developed communities of Cohoe and Kasilof, 
connecting the coast to Tustumena Lake and Harding Icefield in the Kenai Mountains. At its mouth, the 
Kasilof River Flats Important Bird Area (IBA) supports a biodiverse estuarine delta that provides 
important stopover feeding areas for migrant waterfowl and shorebirds, including globally significant 
habitat for the rock sandpiper (Calidris ptilocnemis). In addition to providing habitat for 165 observed 
bird species, the Kasilof River also supports salmon runs that have long supported subsistence fishing for 
the Dena’ina people, as well as a large personal use fishery for Alaska residents. 

Despite the importance of this location for fish and wildlife resources, portions of the lower Kasilof River 
are under threat of development. In response and with support from ConocoPhillips and the U.S. Fish 
and Wildlife Service under NFWF’s SPIRIT of Conservation grant program19 and other funding partners, 
The Conservation Fund partnered with the State of Alaska to acquire 309 acres and 2.25 miles of the 
Kasilof River under a wildlife-oriented deed restriction (Figure 33). 

Figure 33. Map showing the boundary of the acquired parcel now under management by the Alaska Division of Parks 
and Outdoor Recreation in yellow. 

 
19 https://www.nfwf.org/programs/conocophillips-spirit-conservation-program  

https://www.nfwf.org/programs/conocophillips-spirit-conservation-program
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The newly acquired land will be associated with the Old Kasilof Landing State Recreational Site and 
managed by the Alaska Division of Parks and Outdoor Recreation. Together with the adjacent Kasilof 
Special Use Area, the newly acquired land will bring 51 percent of the Kasilof River Flats IBA under state 
protection. The Terrestrial, Aquatic, and combined Fish and Wildlife Index results from the Alaska 
Assessment highlight the importance of this location for many species of conservation and subsistence 
concern (Figure 34). The expanded park lands will also enhance public use, creating recreational 
opportunities for bird and wildlife viewing. 

Figure 34. (a) Terrestrial Index, (b) Aquatic Index, and (c) Fish and Wildlife Index results along the Kasilof 
River and floodplain reveal high values. The yellow line outlines the location of the acquired parcel.  

Protecting this land from development is also critical to ensure human community assets are not built 
within areas exposed to flooding threats (Figure 35). Furthermore, maintaining the presence of 
undisturbed habitat may continue to buffer nearby residents from flooding impacts. The final Resilience 
Hubs demonstrate the importance of conserving this high priority area (Figure 36). 

Figure 35. (a) Threat Index, (b) Community Asset Index, and (c) Community Exposure Index results along 
the Kasilof River show numerous exposed community assets near the acquired parcel outlined in yellow.  
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Figure 36. Resilience Hubs along the Kasilof River highlight the suitability of this area for nature-based resilience 
projects with potential to benefit fish and wildlife and help build community resilience to flooding threats. The 

Resilience Hub Grid shows 4-hectare (10-acre) hexagons covering areas of open space. The yellow line outlines the 

location of the acquired parcel.  
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4.3 Local Adaptation Planning 

While some communities have already begun implementing innovative nature-based strategies, other 
communities require additional data, planning, and capacity to explore and implement projects. While 
this Alaska Assessment can serve as a starting place for regional and state-wide planning, communities 
still require more detailed, local analysis to better characterize risk and develop tailored solutions. With 
funding from the National Coastal Resilience Fund and other sources, the Alaska Native Tribal Health 
Consortium, State of Alaska Department of Natural Resources, and State of Alaska Division of 
Community and Regional Affairs are working to gather local data and model flooding and erosion risks 
for 44 communities (Figure 37), all of which received high exposure values in this Alaska Coastal 
Resilience Assessment. This important planning effort will provide baseline data to support future 
studies, help communities better understand the risks they face, and begin to develop a suite of 
solutions including nature-based approaches. For more information about assessment and planning 
efforts for communities throughout Alaska, visit the Department of Natural Resources Geological and 
Geophysical Survey Coastal Hazards webpage20. 

 
Figure 37. Example products displaying a Coastal Flood Impact Map for Alakanuk, Alaska. The maps show the location 
of important community assets in relation to major flooding (purple shading) expected to result in extensive 
inundation of structures and roads and minor flooding (yellow shading) expected to result in minimal to no property 
damage. Areas subject to major flooding are expected to result in the need for significant evacuation of people and/or 
transfer of property to higher elevations.  

 
20 https://dggs.alaska.gov/hazards/coastal/  

https://dggs.alaska.gov/hazards/coastal/


49 
 

CONCLUSION 
 

5.1 Summary and Key Takeaways 

As communities in Alaska face current and future flooding threats, tools such as this Coastal Resilience 
Assessment can help decision-makers and other stakeholders use data to make informed decisions 
about how to identify areas that may be suitable for resilience-focused, nature-based projects. NFWF 
and NOAA remain committed to supporting programs and projects that improve community resilience 
by reducing communities’ vulnerability to coastal storms, sea-level rise, and other types of coastal 
flooding by strengthening natural ecosystems and the fish and wildlife habitat they provide. 

The Alaska Assessment identified many communities highly exposed to flood related threats, 
particularly remote communities in Western and Northern Alaska. The Assessment also reveals an 
ecologically diverse landscape with an abundance of fish and wildlife assets. Combining the information 
in the Fish and Wildlife Index with the Community Exposure Index, numerous Resilience Hubs are found 
throughout the study area representing areas where resilience-building projects may benefit both 
human and wildlife communities. 

As with all GIS analyses, site-level assessments are required to validate results and develop detailed 
design and engineering plans. The Regional Assessments are intended to be used as a screening-level 
tool designed to help identify areas that may be well suited for nature-based solutions. The results are 
limited by those data available at the time of analysis and by the underlying accuracy and precision of 
the original data sources; therefore, the Assessment may not capture all flood-related threats, 
community assets, fish and wildlife resources, or areas of open space. Resilience Hubs are not intended 
to identify all potential opportunities for nature-based solutions, but rather are meant to help assess 
potential projects based on dual benefits for habitats and human communities. 

5.2 Future Work 

The Regional Coastal Resilience Assessments were developed through an iterative process supported by 
substantial guidance from technical and regional experts. The Regional Assessments and the associated 
Coastal Resilience Evaluation and Siting Tool (CREST) will continue to be updated, refined, and expanded 
by NFWF in the future as appropriate. The overarching methodology will continue to be vetted and 
refined as needed through ongoing Regional Assessments across the United States. The application and 
continued development of the Assessments will assist NFWF and others in the implementation of 
nature-based solutions that build community resilience to flooding threats while benefiting fish and 
wildlife populations nationwide.  
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APPENDIX 
 

The Alaska Coastal Resilience Assessment was completed at a 30-meter resolution, using the projection 
NAD 1983 Alaska Albers Equal Area Conic (WKID 3338). The following sections describe data, methods, 
and other detailed information that were used for the Alaska Assessment. 

A. Data Gaps  
Several important data gaps and needs were identified in the development of the Alaska Coastal 
Resilience Assessment. There were several factors that precluded the use of certain data in the 
Assessment, including those data that were only available for a portion of the study area or lacked 
supporting metadata or other documentation. The Assessment utilized the best available spatial data at 
the time of modeling but does not consider all potential flood-related threats, critical community assets, 
or species information due to data limitations. For instance, important coastal flood-related threats such 
as sea level rise and storm surge lack statewide geospatial coverage in formats accessible to this 
Assessment. In other cases, data such as sea ice extent were only available in daily or seasonal formats 
that did not conform to the types of data required for the Assessment. The Project Team did not gather 
or generate any new data for this effort and datasets that were not spatially explicit were not included. 
For a recent review of flood hazard related data and knowledge gaps in Alaska see Williams & Erikson 
(2021). 

A.1 Data Inputs not Included in the Alaska Assessment 
Several important datasets were not included in the Alaska Assessment due to significant data gaps and 
limitations. 

Sea level rise – data not available for most of the study area 
Sea level rise data are used in all other Regional Coastal Resilience Assessments but were unavailable for 
Alaska. Sea level rise models estimate potential inundation from future sea level rise projections. They 
are often available in one-foot increment scenarios ranging from current mean higher high water to six-
foot. While estimates of relative sea level rise are available in some areas, these data are not available 
for most of the state. This is a major data gap that was voiced by participants in the Assessment’s 
development that hinders modeling and adaptation planning efforts. 

Storm surge – complete spatial data unavailable, data format incompatible with Assessment 
Storm surge data are used in most other Regional Coastal Resilience Assessments but were unavailable 
for Alaska. Storm surge models estimate inundation associated with specific storm scenarios and are 
important to understand coastal flood-related hazards. While the Extratropical Storm Surge Water Level 
Guidance for Alaska provides station-level observations and projections, continuous geospatial data 
summarized over time for the entire state are unavailable. 

Sea ice extent – data format incompatible with Assessment 
There are several available data sets that measure observed and model future sea ice extent including 
winter seasonal maximums and summer seasonal lows (e.g., National Weather Service Alaska Sea Ice 
Program, NOAA's Pacific Marine Environmental Laboratory downscaled climate forecasts using the 
Canadian Center for Climate Modeling and Analysis (CCCma) model, Alaska Center for Climate 
Assessment and Policy). However, these data were incompatible with the Assessment methods, which 
require a single, continuous input that depicts changes in flood hazard associated with changing sea ice 
conditions. 

https://portal.aoos.org/#metadata/71e489ca-a57e-4685-94c9-1f6bd74cc511/9893d2e7-c339-477a-93fe-ef49c4db6fe9
https://portal.aoos.org/#metadata/71e489ca-a57e-4685-94c9-1f6bd74cc511/9893d2e7-c339-477a-93fe-ef49c4db6fe9
https://portal.aoos.org/#metadata/71e489ca-a57e-4685-94c9-1f6bd74cc511/9893d2e7-c339-477a-93fe-ef49c4db6fe9
https://www.weather.gov/afc/ice
https://www.weather.gov/afc/ice
https://www.weather.gov/afc/ice
https://portal.aoos.org/#metadata/4f706756-7d57-11e3-bce5-00219bfe5678/4733259d-c426-4c59-9017-424cf632ba04
https://portal.aoos.org/#metadata/4f706756-7d57-11e3-bce5-00219bfe5678/4733259d-c426-4c59-9017-424cf632ba04
https://portal.aoos.org/#metadata/4f706756-7d57-11e3-bce5-00219bfe5678/4733259d-c426-4c59-9017-424cf632ba04
https://uaf-accap.org/air-temperature/sea-ice/
https://uaf-accap.org/air-temperature/sea-ice/
https://uaf-accap.org/air-temperature/sea-ice/
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Subsistence hunting and fishing areas – complete spatial data unavailable 
Subsistence hunting and fishing provide critical food and cultural resources for Alaskan residents. While 
information is available that describes the location of fish camp allotments and/or hunting grounds for 
subsistence resources (e.g., Subsistence Resources Used by Kaktovik, Nuiqsut and Utqiaġvik, Community 
Observer interactive map of subsistence communities where various surveys have occurred), not all data 
are spatially explicit and data coverage is limited. In some instances, publicly available data are limited 
or generalized to protect sensitive information. Due to the importance of subsistence resources, the 
Alaska Assessment used fishing and non-fishing subsistence harvest records from the Alaska 
Department of Fish and Game to identify species to include in habitat suitability models for the Fish and 
Wildlife Index. 

Benthic habitat – incomplete data 
The Aquatic Index methods rely on species distribution and habitat type information. In other regions, 
spatial data for nearshore marine benthic habitats were available to inform the Aquatic Index. In Alaska, 
while benthic habitat and/or substrate type data are available for some areas (e.g., the Kachemak Bay 
NOAA Habitat Focus Area), it was not available statewide and thus could not be included in the 
Assessment. 

A.2 Data Inputs Included in the Alaska Assessment with Limited Coverage 
In some cases, data sets that had important gaps or limitations were included in the Alaska Assessment. 
Updated or more complete datasets would improve the Assessment results. 

Flood-prone areas – poor spatial coverage 
A common input for all Regional Coastal Resilience Assessments, flood-prone areas combine Federal 
Emergency Management Agency (FEMA) National Flood Hazard Layer (NFHL) and the U.S. Department 
of Agriculture -Natural Resources Conservation Service (USDA-NRCS) Gridded National Soil Survey 
Geographic Database (gNATSGO) to identify areas most exposed to flooding. In Alaska, Communities 
Participating in the National Flood Program were limited therefore the Assessment used the FEMA 
National Risk Index Coastal and Riverine flooding hazard types by Census Tract where available. These 
data were combined with the Statewide Threat Assessment (UAF 2019) and gNATSGO soils data. The 
limitations of gNATSGO are described under the soil survey data heading below. 

Soil survey data – poor spatial coverage 
A common input for all Regional Coastal Resilience Assessments, the detailed USDA-NRCS Soil Survey 
Geographic Database (SSURGO) based on field observations and soil samples is used to describe soil 
characteristics including flood factors such as erodibility and drainage. In Alaska, these detailed surveys 
are only available for approximately 15 percent of Alaska. State-wide soil data are available through the 
Alaska Soil Survey using the State Soil Geographic (STATSGO) dataset, which generalizes more detailed 
soil survey maps and classifies the remaining area based on geology, topography, vegetation, and 
climate. The Threat Index for the Alaska Assessment used the USDA-NRCS Gridded National Soil Survey 
Geographic Database (gNATSGO) as it combines the best available soils data into a single composite 
dataset with complete coverage More consistent, state-wide soils data based on detailed soil surveys 
are needed and would improve the Alaska Assessment results. 

Tsunami inundation– not available for all communities 
Tsunami data typically describe the amount of inundation that could be experienced due to a tsunami 
and/or where evacuation zones exist (often in the absence of inundation data). The Threat Index for the 
Alaska Assessment used the Alaska Division of Geological and Geophysical Surveys Tsunami inundation 
maps, available for many but not all communities. Therefore, areas without tsunami data do not 

https://portal.aoos.org/#module-metadata/c2bacbd5-d323-4069-a09a-262ce6ebaf7c
https://portal.aoos.org/#module-metadata/c2bacbd5-d323-4069-a09a-262ce6ebaf7c
http://www.adfg.alaska.gov/sb/CSIS/index.cfm?ADFG=main.CommObs
http://www.adfg.alaska.gov/sb/CSIS/index.cfm?ADFG=main.CommObs
http://www.adfg.alaska.gov/sb/CSIS/index.cfm?ADFG=main.CommObs
https://gis.data.alaska.gov/datasets/DCCED::subsistence-harvests-fishing-resources/about
https://gis.data.alaska.gov/datasets/DCCED::subsistence-harvests-non-fishing-resources/about
https://coastalscience.noaa.gov/news/new-mapping-tool-lets-users-explore-bottom-habitats-of-kachemak-bay-alaska/
https://coastalscience.noaa.gov/news/new-mapping-tool-lets-users-explore-bottom-habitats-of-kachemak-bay-alaska/
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcs142p2_053628
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.fema.gov/cis/AK.html
https://www.fema.gov/cis/AK.html
https://hazards.fema.gov/nri/
https://hazards.fema.gov/nri/
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcs142p2_053628
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcs142p2_053628
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcs142p2_053628
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcs142p2_053628
https://gis.data.alaska.gov/datasets/seakgis::alaska-soil-survey-usfs-/about
https://gis.data.alaska.gov/datasets/seakgis::alaska-soil-survey-usfs-/about
https://gis.data.alaska.gov/datasets/seakgis::alaska-soil-survey-usfs-/about
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcs142p2_053628
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625
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necessarily indicate those areas are not at risk from inundation due to tsunami. A list of the mapped 
communities can be found here (https://dggs.alaska.gov/pubs/tsunami). 

National Wetland Inventory – poor spatial coverage 
The U.S. Fish and Wildlife Service National Wetlands Inventory is a foundational dataset used in all 
Regional Coastal Resilience Assessments to identify the location, type, and extent of wetland and deep-
water habitats. Data were included wherever available, but coverage is limited throughout much of 
Alaska. 

Human community assets – incomplete data (varies by region) 
The Community Asset Index for the Alaska Assessment relies on spatial data identifying the location of 
critical infrastructure. Many datasets were used to identify community assets (see Appendix B for a list 
of all data included in the Assessment); however, not all forms of infrastructure are well mapped (e.g., 
transportation infrastructure) and additional mapping of community assets would be beneficial to 
improve the Assessment. 

Social vulnerability – data available at coarse resolution 
Data from the Denali Commission were included in the Community Asset Index of the Alaska 
Assessment. Where those data were unavailable, the U.S. Environmental Protection Agency’s 
Environmental Justice Screening Tool (EJScreen) was used; these data are provided at the Census Block 
level and do not capture variation among communities within the same block, which are often very 
large. Other methods to estimate social vulnerability, such as NOAA Alaska Fisheries Science Center 
Community Profiles for North Pacific Fisheries did not have spatially explicit data available. 

Species distribution, range, and habitat use – variable by species group 
The Fish and Wildlife Index methods rely on species distribution, range, and habitat use data for species 
of conservation concern or subsistence use. Data for all species identified in the Alaska Wildlife Action 
Plan, threatened or endangered species under the U.S. Endangered Species Act, species with Essential 
Fish Habitat, and subsistence species were included wherever available. However, species distribution 
and range data were not available for all species. Most notably, small mammals are largely absent from 
the Alaska Assessment as data were not available. 
  

https://dggs.alaska.gov/pubs/tsunami
https://www.fws.gov/program/national-wetlands-inventory/wetlands-mapper
https://www.fws.gov/program/national-wetlands-inventory/wetlands-mapper
https://www.epa.gov/ejscreen
https://www.epa.gov/ejscreen
https://www.epa.gov/ejscreen
https://reports.psmfc.org/akfin/f?p=501%3A2003
https://reports.psmfc.org/akfin/f?p=501%3A2003
https://reports.psmfc.org/akfin/f?p=501%3A2003
https://reports.psmfc.org/akfin/f?p=501%3A2003
https://reports.psmfc.org/akfin/f?p=501%3A2003
https://reports.psmfc.org/akfin/f?p=501%3A2003
https://reports.psmfc.org/akfin/f?p=501%3A2003
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B. Data Summary 

B.1 Threat Index 

The following is a comprehensive list of datasets used to create the Threat Index for the Alaska Coastal 
Resilience Assessment. 

Layer Name Dataset and Source 

Flood-prone Areas FEMA National Risk Index (Coastal and Riverine Flooding Annualized Frequency), USDA-
NRCS gNATSGO, UAF et al. 2019 

Areas of Low Slope IFSAR Digital Terrain Model, resampled to 30-meter resolution 

Soil Erodibility USDA-NRCS gNATSGO, UAF et al. 2019 

Tsunami Inundation Alaska Dept. of Natural Resources, Alaska Earthquake Center, and the Alaska Division of 
Homeland Security and Emergency Management Tsunami Inundation Mapping 

Permafrost Thaw Hjort et al. 2018, UAF et al. 2019 

Community 
Footprints 

Alaska Dept. of Commerce, Community, & Economic Development, Division of 
Community and Regional Affairs “Community Transportation Overview", Places (Cities 
and Census Designated Places), Census Blocks, city boundaries 

B.2 Community Asset Index 

The following is a comprehensive list of datasets used to create the Community Asset Index for the 
Alaska Coastal Resilience Assessment.  

Layer Name Dataset and Source 

Social Vulnerability Denali Commission Distressed Communities Report (2020), U.S. EPA EJSCREEN 

Community 
Footprints 

Alaska Dept. of Commerce, Community, & Economic Development, Division of 
Community and Regional Affairs “Community Transportation Overview”, Places (Cities 
and Census Designated Places), Census Blocks, city boundaries 

Critical Facilities Alaska Dept. of Health and Social Services, Division of Public Health “Healthcare 
Facilities: Healthcare SafetyNet Directory” 
Alaska Dept. of Public Safety “Fire Departments” 
Alaska Dept. of Education & Early Development “Schools: PK-12”  
Alaska Dept. of Public Safety "Village Public Safety Officers" 
Alaska Dept. of Commerce, Community, and Economic Development, Division of 
Community and Regional Affairs "Post Offices" 

https://hazards.fema.gov/nri/data-resources
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://www.usgs.gov/centers/eros/science/usgs-eros-archive-digital-elevation-interferometric-synthetic-aperture-radar
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625#:~:text=The%20gridded%20National%20Soil%20Survey,United%20States%20and%20Island%20Territories.
https://dggs.alaska.gov/pubs/tsunami
https://dggs.alaska.gov/pubs/tsunami
https://gis.data.alaska.gov/datasets/4cbaa40cacfc48ec902ad52095fc370b_0/about
https://gis.data.alaska.gov/datasets/4cbaa40cacfc48ec902ad52095fc370b_0/about
https://live.laborstats.alaska.gov/cen/maps.cfm
https://live.laborstats.alaska.gov/cen/maps.cfm
https://live.laborstats.alaska.gov/cen/maps.cfm
https://gis.data.alaska.gov/datasets/DCCED::city-boundaries/about
https://secureservercdn.net/198.71.233.52/02e.11d.myftpupload.com/wp-content/uploads/2020/08/2020DistressedCommunitiesReport.pdf
https://www.epa.gov/ejscreen
https://gis.data.alaska.gov/datasets/4cbaa40cacfc48ec902ad52095fc370b_0/about
https://gis.data.alaska.gov/datasets/4cbaa40cacfc48ec902ad52095fc370b_0/about
https://live.laborstats.alaska.gov/cen/maps.cfm
https://live.laborstats.alaska.gov/cen/maps.cfm
https://live.laborstats.alaska.gov/cen/maps.cfm
https://gis.data.alaska.gov/datasets/DCCED::city-boundaries/about
https://dcra-cdo-dcced.opendata.arcgis.com/datasets/healthcare-facilities-healthcare-safetynet-directory
https://dcra-cdo-dcced.opendata.arcgis.com/datasets/healthcare-facilities-healthcare-safetynet-directory
https://dcra-cdo-dcced.opendata.arcgis.com/datasets/fire-departments
https://dcra-cdo-dcced.opendata.arcgis.com/datasets/schools-pk-12
https://dcra-cdo-dcced.opendata.arcgis.com/datasets/village-public-safety-officers-vpso
https://dcra-cdo-dcced.opendata.arcgis.com/datasets/post-offices-1
https://dcra-cdo-dcced.opendata.arcgis.com/datasets/post-offices-1
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Layer Name Dataset and Source 

Critical Transportation Infrastructure (Various Inputs, see below) 

Primary roads Alaska Dept. of Transportation & Public Facilities "Roads" 

Airport runways Homeland Infrastructure Foundation-Level Data (HIFLD) 

Railroads Alaska Dept. of Commerce, Community, & Economic Development "Alaska Railroad Centerline" 

Bridges Alaska Dept. of Transportation & Public Facilities "Bridges" 

Ferry Terminals Alaska Dept. of Commerce, Community, & Economic Development "Alaska Marine Highway Ferry 
Terminals" 

Ports and Harbors Alaska Dept. of Commerce, Community, & Economic Development "Ports and Harbors" 

Critical Infrastructure (Various inputs, see below) 

Wastewater treatment 
facilities 

Alaska Dept. of Environmental Conservation Division of Water "Wastewater Treatment" 
Alaska Dept. of Environmental Conservation "Wastewater Collection", AK Certified 
Water/Wastewater Operator Database 

Power 
Plants/Substations 

EIA-860, Annual Electric Generator Report; EIA-860M, Monthly Update to the Annual Electric 
Generator Report; and EIA-923, Power Plant Operations Report (U.S. Energy Information 
Administration)  

Major dams USACE National Inventory of Dams: Dam Lines 

Petroleum terminals  U.S. Energy Information Administration: EIA-815, Monthly Bulk Terminal and Blender Report 

Petroleum Refineries U.S. Energy Information Administration: EIA-820 Refinery Capacity Report 

Hazardous Sites Alaska Dept. of Environmental Conservation “Solid Waste Landfills” 
Alaska Dept. of Environmental Conservation "Solid Waste Sites" 

Water Distribution Alaska Dept. of Environmental Conservation, Division of Water "Water Distribution" 

Communication 
Infrastructure 

Homeland Infrastructure Foundation-Level Data (HIFLD) Microwave Service Towers and FM 
Transmission Towers 

Bulk Fuel Storage Alaska Energy Authority "Bulk Fuel Inventory Facilities" 

Department of Defense 
sites 

Homeland Infrastructure Foundation-Level Data (HIFLD) DoD Sites Boundaries (Public) 

 

  

https://dcra-cdo-dcced.opendata.arcgis.com/datasets/roads-2?geometry=-147.575%2C56.269%2C-114.198%2C60.306
https://hifld-geoplatform.opendata.arcgis.com/datasets/runways
https://dcra-cdo-dcced.opendata.arcgis.com/datasets/DCCED::alaska-railroad-centerline/about
https://gis.data.alaska.gov/datasets/AKDOT::bridges/explore?location=60.211030%2C-144.118706%2C5.91
https://gis.data.alaska.gov/datasets/DCCED::alaska-marine-highway-ferry-terminals/explore?location=55.718208%2C30.962550%2C4.58
https://gis.data.alaska.gov/datasets/DCCED::alaska-marine-highway-ferry-terminals/explore?location=55.718208%2C30.962550%2C4.58
https://gis.data.alaska.gov/datasets/DCCED::ports-and-harbors/explore
https://dcra-cdo-dcced.opendata.arcgis.com/datasets/wastewater-treatment
https://dcra-cdo-dcced.opendata.arcgis.com/datasets/wastewater-collection
https://dec.alaska.gov/Applications/Water/OpCert/Home.aspx?p=OperatorSearch
https://dec.alaska.gov/Applications/Water/OpCert/Home.aspx?p=OperatorSearch
https://www.eia.gov/maps/layer_info-m.php
https://www.eia.gov/maps/layer_info-m.php
https://www.eia.gov/maps/layer_info-m.php
https://nid.usace.army.mil/#/
https://www.eia.gov/maps/layer_info-m.php
https://www.eia.gov/maps/layer_info-m.php
https://dcra-cdo-dcced.opendata.arcgis.com/datasets/landfills?geometry=149.921%2C35.066%2C56.933%2C69.855
https://dcra-cdo-dcced.opendata.arcgis.com/datasets/solid-waste-sites-1
https://dcra-cdo-dcced.opendata.arcgis.com/datasets/water-distribution
https://hifld-geoplatform.opendata.arcgis.com/datasets/geoplatform::microwave-service-towers-7/about
https://hifld-geoplatform.opendata.arcgis.com/datasets/fm-transmission-towers
https://hifld-geoplatform.opendata.arcgis.com/datasets/fm-transmission-towers
https://gis.data.alaska.gov/datasets/d30d5a535a644ba48f53c59c7fd0749a
https://hifld-geoplatform.opendata.arcgis.com/datasets/geoplatform::department-of-defense-dod-sites-boundaries-public/about
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B.3 Terrestrial Index 

The following table lists those datasets that were used to create the Terrestrial Index for the Alaska 
Coastal Resilience Assessment. 

Layer Name Dataset and Source 

Important Bird Areas BirdLife International (2020) 

Critical Habitat Designations U.S. FWS 

State Wildlife Action Plan Species 
of Greatest Conservation Concern  

Alaska Dept of Fish and Game State Wildlife Action Plan (2015) 

Subsistence species 
Alaska Department of Fish and Game “Subsistence Harvests: Non-Fishing 
Resources” (determined by the Joint Board of Fisheries and Game) 

Alaska Gap Analysis Project, 
Distribution Models for Terrestrial 
Vertebrate species  

University of Alaska Anchorage, Alaska Center for Conservation Science 
(Gotthart et al. 2014) 

Species range data 
Alaska Natural Heritage Program Wildlife Data Portal (University of Alaska 
Anchorage, Alaska Center for Conservation Science); range data used for 
species not included in the Gap Analysis Project 

Procellarid range data IUCN Redlist 

Arctic caribou herds range data University of Alaska Anchorage, Alaska Center for Conservation Science 

Elk range data Alaska Habitat Management Guides (1985) 

 
  

https://www.audubon.org/important-bird-areas
https://ecos.fws.gov/ecp/report/table/critical-habitat.html
https://www.adfg.alaska.gov/static/species/wildlife_action_plan/2015_alaska_wildlife_action_plan.pdf
https://gis.data.alaska.gov/datasets/DCCED::subsistence-harvests-non-fishing-resources/about
https://gis.data.alaska.gov/datasets/DCCED::subsistence-harvests-non-fishing-resources/about
http://akgap.uaa.alaska.edu/species-data/
https://accs.uaa.alaska.edu/alaska-natural-heritage-program/
https://accs.uaa.alaska.edu/alaska-natural-heritage-program/
https://www.iucnredlist.org/
https://accscatalog.uaa.alaska.edu/dataset/ranges-arctic-alaska-caribou-herds
http://www.adfg.alaska.gov/index.cfm?adfg=maps.habitatmanagement
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B.4 Aquatic Index 

The following table lists those datasets used to create the Aquatic Index for the Alaska Coastal Resilience 
Assessment. 

Layer Name Dataset and Source 

Habitat Classification Scheme  IUCN Red List of Threatened Species (Version 3.1) 

Essential Fish Habitat NOAA Fisheries Alaska Region Habitat Conservation Division 

State Wildlife Action Plan Species 
of Greatest Conservation Concern  

Alaska Dept of Fish and Game State Wildlife Action Plan (2015) 

Subsistence species  
Alaska Department of Fish and Game “Subsistence Harvests: Fishing 
Resources” (determined by the Joint Board of Fisheries and Game) 

Distribution data for anadromous 
fish species 

Alaska Department of Fish and Game Alaska Anadromous Waters Catalog 

Critical Habitat Designations NOAA and U.S. FWS 

Alaska Gap Analysis Project, 
Distribution Models for Terrestrial 
Vertebrate species (marine 
mammals)  

University of Alaska Anchorage, Alaska Center for Conservation Science 
(Gotthart et al. 2014) 

Distribution data for beluga and 
bowhead whales 

Alaska Department of Fish and Game Alaska Habitat Management Guides 
(1985) 

Distribution data for marine 
invertebrate subsistence species 

Kachemak Bay Ecological Characterization (Marine Invertebrate 
Distributions); Cook Inlet Environmental Sensitivity Index (Invertebrates) 
via Alaska Ocean Observing System Ocean Data Explorer 

Intertidal and subtidal vegetation  

Alaska ShoreZone biological attributes including eelgrass, surfgrass, 

Alaria spp., rockweed, and other soft brown, dark brown, dragon, bull, 

and giant kelps 

Misc. species habitat range, 
distribution, nesting sites, etc. 

Kachemak Bay Ecological Characterization (Finfish Distributions), Audubon 

Alaska (North Pacific cods, Pacific halibut, capelin, Pacific herring, Atka 

mackerel, red king crab) via Alaska Ocean Observing System Ocean Data 
Explorer 

B.5 Protected & Managed Areas for Wildlife 

Layer Name Dataset and Source 

Protected Areas Managed for 
Biodiversity  

USGS Protected Areas Database of the U.S. (PADUS) (Version 2.0) 

State Refuges, Sanctuaries, Critical 
Habitat Areas, and Wildlife Ranges 

Alaska Department of Fish and Game 

  

https://www.iucn.org/content/iucn-red-list-categories-and-criteria-version-31
https://www.fisheries.noaa.gov/alaska/habitat-conservation/essential-fish-habitat-efh-alaska
https://www.adfg.alaska.gov/static/species/wildlife_action_plan/2015_alaska_wildlife_action_plan.pdf
https://gis.data.alaska.gov/datasets/DCCED::subsistence-harvests-fishing-resources/about
https://gis.data.alaska.gov/datasets/DCCED::subsistence-harvests-fishing-resources/about
https://soa-adfg.opendata.arcgis.com/datasets/alaska-anadromous-waters-catalog/data?geometry=-164.992%2C59.235%2C-148.303%2C61.146&layer=0
https://www.fisheries.noaa.gov/national/endangered-species-conservation/critical-habitat
https://ecos.fws.gov/ecp/report/table/critical-habitat.html
http://akgap.uaa.alaska.edu/species-data/
http://www.adfg.alaska.gov/index.cfm?adfg=maps.habitatmanagement
http://www.adfg.alaska.gov/index.cfm?adfg=maps.habitatmanagement
https://portal.aoos.org/#module-metadata/142f03ec-5cf1-11e1-9b46-0019b9dae22b
https://portal.aoos.org/#module-metadata/142f03ec-5cf1-11e1-9b46-0019b9dae22b
https://portal.aoos.org/#module-metadata/ad7128a4-ea24-11e0-b14c-0019b9dae22b/ee8c6e3e-ea24-11e0-a277-0019b9dae22b
https://www.fisheries.noaa.gov/alaska/habitat-conservation/alaska-shorezone
https://portal.aoos.org/#module-metadata/142f03ec-5cf1-11e1-9b46-0019b9dae22b/1c5c9a2c-627b-11e1-b2ce-0019b9dae22b
https://portal.aoos.org/#module-metadata/d0ed6b68-5735-11e9-aee4-0023aeec7b98
https://portal.aoos.org/#module-metadata/6b688864-51b2-11e9-a5f1-0023aeec7b98
https://portal.aoos.org/#module-metadata/a5664fa0-5735-11e9-865a-0023aeec7b98
https://portal.aoos.org/#module-metadata/cdad1d54-5735-11e9-84f0-0023aeec7b98
https://portal.aoos.org/#module-metadata/31e1d00a-51b2-11e9-bb31-0023aeec7b98
https://portal.aoos.org/#module-metadata/31e1d00a-51b2-11e9-bb31-0023aeec7b98
https://portal.aoos.org/#module-metadata/ec8b5cec-51b1-11e9-b02d-0023aeec7b98
https://www.usgs.gov/programs/gap-analysis-project/science/protected-areas
https://www.adfg.alaska.gov/index.cfm?adfg=maps.refugeboundaries


60 
 

B.6 Resilience Hubs 

Layer Name Dataset and Source 

National Hydrology Dataset  USGS National Hydrology 

National Land Cover Dataset, 2016 Multi-Resolution Land Characteristics (MRLC) Consortium - USGS, EPA, 
NOAA, BLM, NASA, NPS, USDA-NASS, USFWS, US Army COE 

National Elevation Dataset, NED 
30-meter 

U.S. Geological Survey (USGS), EROS Data Center 

12-Digit Watershed Boundary 
Dataset 

United States Geological Survey (USGS) 

Soils U.S. Department of Agriculture, National Soil Survey Center, National 
Coordinated Major Land Resource Area (MLRA) Version 4.2 

TIGER Primary and Secondary 
Roads 

U.S. Department of Commerce, U.S. Census Bureau, Geography Division, 
2021 

TIGER Streets U.S. Department of Commerce, U.S. Census Bureau, Geography Division, 
2021 

TIGER Rail Lines U.S. Department of Commerce, U.S. Census Bureau, Geography Division, 
2021 

Wetlands U.S. Fish & Wildlife Service, National Wetlands Inventory 

Incorporated places and U.S. 
Census Designated Places 

U.S. Census Bureau, ESRI 

  

https://www.usgs.gov/national-hydrography
https://www.mrlc.gov/data/nlcd-2016-land-cover-alaska
https://www.mrlc.gov/data/nlcd-2016-land-cover-alaska
https://www.usgs.gov/programs/national-geospatial-program/national-map
https://www.usgs.gov/national-hydrography/watershed-boundary-dataset
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/?cid=nrcs142p2_053624
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/?cid=nrcs142p2_053624
https://www.census.gov/geographies/mapping-files/time-series/geo/tiger-line-file.html
https://www.census.gov/geographies/mapping-files/time-series/geo/tiger-line-file.html
https://www.census.gov/geographies/mapping-files/time-series/geo/tiger-line-file.html
https://www.census.gov/geographies/mapping-files/time-series/geo/tiger-line-file.html
https://www.census.gov/geographies/mapping-files/time-series/geo/tiger-line-file.html
https://www.census.gov/geographies/mapping-files/time-series/geo/tiger-line-file.html
https://www.fws.gov/node/264847
https://hub.arcgis.com/datasets/esri::usa-census-populated-places/about
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C. Detailed Methodology: Threat Index 

C.1 Create the Areas of Low Slope Input 
A. Use the Raster Clip tool to clip the IFSAR digital terrain model to the regional boundary 

a. Data management tools > Raster > Raster Processing > Clip  
B. Create a slope raster from the clipped raster using the Slope Tool 

a. Spatial Analyst Tools > Surface > Slope 
i. Output Measurement: Percent rise 

C. Reclassify the Slope raster to a ranked output  
a. Spatial Analyst Tools > Reclass > Reclassify 

i. Choose the Percent Rise raster as the input raster 
ii. Create a distribution with corresponding rank values according to the table 

below 
D. Shift the raster  

a. Data and Management Tools > Projections and Transformations > Raster > Shift 
b. Shift X & Y Coordinates by: 1 (each) 
c. Snap to: varies by region 

Slope (%) Rank Type Rank Value 

 > 2.00 None 0 

1.00 – 2.00  Very low 1 

0.75 – 1.00 Low 2 

0.50 – 0.75 Moderate 3 

0.25 – 0.50 High 4 

< 0.25 Very high 5 

 

C.2 Create the Soil Erodibility Input 

Create the gNATSGO grid for the attribute “kffact” to evaluate soil erodibility: 

A. Add the provided 10-meter grid to the map and resample, if necessary. For Alaska, the raster 
was resampled to 30-meters.  

d. Data Management Tools > Raster > Raster Processing > Resample:  
i. Input: 10-meter 
ii. output : 30-meter 

iii. X: 30; Y: 30 
iv. Resampling technique: NEAREST 

B. Run the “Create Soil Map” tool from the USDA-NRCS Soil Data Development Toolbox (download 
data as needed) 

a. To create a soils raster for the “kffact” attribute:  
i. Map Unit Layer = MapunitRaster_30m 

1. SDV Folder = Soil Erosion Factors 
2. SDV Attribute = K Factor, Whole Soil 
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3. Aggregation Method = Dominant Condition 
b. Export the temporary layer generated by “Create Soil Map” tool :  

i. Right click layer in the Table of Contents > Data > Export Data 
1. Ensure the correct spatial reference and cell size  
2. Enter the correct folder location 
3. Give the raster output a new name with the “.tif” extension 
4. Click “Save” 

Prepare the new Soil Erodibility raster: 

C. Reclassify the “kffact” raster according to the table below.  
D. Clip the reclassified raster to the regional boundary. 

a. Clip Raster:  
i. Check “Use Input Features for Clipping Geometry” 

Soil Erodibility Rank Type Rank Value 

 Null None 0 

< = 0.10 Kffact Very low 1 

0.15 and 0.17 Kffact Low 2 

0.20 – 0.28 Kffact Moderate 3 

0.32 and 0.37 Kffact High 4 

> = 0.43 Kffact Very high 5 

Prepare the Statewide Threat Assessment Community data and calculate the final input: 

E. A community footprints layer was created to distribute community-level data for some threat 
and asset index values compiled by other assessments where a single value was assigned to the 
entire community 

a. Create community footprints polygon layer 
i. Use the Community Transportation Overview Open Data layer maintained by 

the Alaska Department of Commerce Community and Economic Development 
Division of Community and Regional Affairs to identify Alaska communities 
(point locations) 

1. Filter out Large population centers (2010 Census population >8,000) 
such as Anchorage along with data scales that are larger than the 
community-level (e.g., boroughs) 

ii. Identify a polygon boundary to correspond to each community point using 
Census Designated Place boundaries, city boundaries, and Census Blocks 
boundaries   

1. As there are sometimes differences in community names between 
sources, crosswalk the datasets through visual comparison of the point 
and polygon locations for each community where there are differences. 
Communities included in the Statewide Threat Assessment (UAF 2019) 
should also be crosswalked with the data to ensure their threat values 
can be joined to the community footprints 
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2. As polygon boundaries are identified for each corresponding community 
point, some community points may need to be removed where multiple 
points correspond to the same polygon boundary (e.g., Fox River) 

3. Merge community boundaries identified for each source into a single 
community footprints layer 

4. Clip community footprints to the regional boundary 
b. Join the STA individual threat evaluations for 187 point locations for communities in 

rural Alaska to the community footprints. This dataset will be used to derive values for 
erosion, flooding, and permafrost within community footprints 

F. Derive values for pixels falling inside the community footprint 
a. Assign a rank value, from 1 to 5, to each community footprint where erosion threat risk 

was assessed by the STA based on the assessment’s assigned individual erosion threat 
risk groupings for each community (1=high, 2=medium, and 3=low) 

i. Using the STA individual erosion threat risk rankings, split communities in 
erosion group 1 into two subsets, and assign the highest-ranking communities in 
group 1 to rank=5, while the lowest-ranking communities in group 1 are 
assigned rank=4. Similarly, the highest-ranking communities in erosion group 2 
are assigned rank=3 while the lowest-ranking communities in are assigned 
rank=2. All communities in erosion group 3 are assigned rank=1. (See figure 
below.) 

 

G. Rasterize the ranked communities and mosaic these communities into the soils raster, ensuring 
that pixels inside community footprints of communities assessed by the STA take their value 
from the STA rank, not from the soils raster. 
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C.3 Create the Flood-Prone Areas Input 

Create the gNATSGO grid for the attribute “flodfreqmax” to evaluate flood-prone soils: 

A. Run the “Create Soil Map” tool from the USDA-NRCS Soil Data Development Toolbox (download 
data as needed) 

a. To create a soils raster for the “flodfreqmax” attribute:  
i. Map Unit Layer = MapunitRaster_30m 
ii. SDV Folder = Water Features 

iii. SDV Attribute = Flooding Frequency Class 
iv. Aggregation Method = Max 

B. Export the temporary layer generated by “Create Soil Map” tool :  
a. Right click layer in the Table of Contents > Data > Export Data 

i. Ensure the correct spatial reference and cell size  
ii. Enter the correct folder location 

iii. Give the raster output a new name with the “.tif” extension 
iv. Click “Save” 

Prepare the new flood-prone soils raster: 

C. Reclassify the “flodfreqmax” raster according to the table below  
D. Clip the reclassified raster to the regional boundary 

a. Clip Raster:  
i. Check “Use Input Features for Clipping Geometry” 

Prepare the FEMA floodplain data: 

E. Create a new field in the attribute table to combine the attributes “Coastal Flooding Annualized 
Frequency” and “Riverine Flooding Annualized Frequency” 

a. Right click layer in Table of Contents > Attribute Table > +Add 
i. Field Name: CombFlood; Type: Double 

b. Calculate field “CombFlood”:  
i. Right click field > Calculate Field:  

1. = CFLD_AFREQ + RFLD_AFEQ 
F. Rank the newly combined flood frequency field according to the table below.  

a. In the layer’s attribute table choose “+Add” to add a new field:  
i. Name: Rank; Type: Short 

b. Select by attributes where CombFlood is < 1% and >= 1% and <= 2%, ranking each as 
they are selected according to the table below 
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Flood Likelihood Rank 

None (or no data coverage) 0 

Combined Flood: less than 1% chance 1 

Combined Flood: 1-2% chance (100- or 500- year floodplain) 2 

Occasionally-flooded soils (gNATSGO) 3 

Frequently-flooded soils (gNATSGO) 4 

Restrict flood-prone areas by elevation mask: 

The project team used an elevation mask to restrict flood-prone areas. The elevation mask was used to 
remove the flood-prone areas input in areas of high elevation, assuming that areas of elevation greater 
than 20 m are unlikely to flood (personal communication with Advisory Committee). While these areas 
still receive values in the Threat Index, their values are lower because they do not experience the threat 
of flooding. 

G. Set pixels in the floodfreqmax/soils raster to 0 in areas where elevation is greater than 20 or less 
than or equal to 0 

Prepare the Statewide Threat Assessment Community data and calculate the final input: 

H. Derive values for pixels falling inside the community footprint 
a. Assign a rank value, from 1 to 5, to each community footprint where flooding threat risk 

was assessed by the STA (UAF 2019) based on the assessment’s assigned individual 
flood threat risk groupings for each community (1=high, 2=medium, and 3=low) 

Using the STA individual flood threat risk rankings, split communities in flood group 1 into two subsets, 
and assign the highest-ranking communities in group 1 to rank=5, while the lowest-ranking communities 
in group 1 are assigned rank=4. Similarly, the highest-ranking communities in flood group 2 are assigned 
rank=3 while the lowest-ranking communities in are assigned rank=2. All communities in flood group 3 
are assigned rank=1. (See figure below.) 
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I. Rasterize the ranked communities and mosaic these communities into the flodfreqmax/soils 
raster, ensuring that pixels inside community footprints of communities assessed by the STA 
take their value from the STA rank, not from the flodfreqmax/soils raster. 

C.4 Create the Permafrost Thaw Input 

Prepare permafrost data input: 

The project team used the “geohazard risk index” due to permafrost thaw published by Hjort et al. 
(2018). As this index is already a direct indicator of threat, the project team simply reclassified the index 
from a 3-level index to a 5-level index (level 1 was reclassified to 1; level 2 was reclassified 3; level 3 was 
reclassified to 5). 

A. Import the geohazard risk index data layer (consensus geohazard risk for RCP2.6 and time 
period 2041-2060), clip it to the regional boundary, project, and resample to match other threat 
index inputs. 

B. Reclassify the geohazard risk index to a scale of 1-5 

Geohazard risk index value Rank Type Rank Value 

None None 0 

1 Low hazard potential 1 

2 Moderate hazard potential 3 

3 High hazard potential 5 

C. Mosaic ranked risk index with the regional boundary  
a. Tool: Merge 

i. Input features: ranked permafrost risk index and regional boundary 

Prepare the Statewide Threat Assessment Community data and calculate the final input: 

D. Derive values for pixels falling inside the community footprint 
a. Assign a rank value, from 1 to 5, to each community footprint where permafrost threat 

risk was assessed by the STA (UAF 2019) based on the assessment’s assigned individual 
permafrost threat risk groupings for each community (1=high, 2=medium, and 3=low) 

i. Using the STA individual permafrost threat risk rankings, split communities in 
permafrost group 1 into two subsets, and assign the highest-ranking 
communities in group 1 to rank=5, while the lowest-ranking communities in 
group 1 are assigned rank=4. Similarly, the highest-ranking communities in 
group 2 are assigned rank=3, while the lowest-ranking communities in group 2 
are assigned rank=2. All communities in permafrost group 3 are assigned 
rank=1. (See figure below.) 
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E. Rasterize the ranked communities and mosaic these communities into the permafrost raster, 
ensuring that pixels inside community footprints of communities assessed by the STA take their 
value from the STA rank, not from the permafrost raster 

C.5 Create the Tsunami Inundation Input 

Prepare tsunami modeled depth data (rasters): 

A. Import the raster data layer, export with a new name and update the coordinate system 
a. Right click layer in the Table of Contents > Data > Export Raster 

B. Reclassify the rasters according to the Alaska Earthquake Map Viewer (see table below) 
C. Mosaic the reclassified rasters 

a. Tool: Mosaic 
i. Inputs: All rasters except one 
ii. Target Raster: Make a copy of the raster that was left out of the inputs and 

name it whatever you want the output to be named. Add the renamed copy as 
the “target”. 

iii. Since there will be no overlap in rasters, leave them in their default settings  
iv. NoData Value: 255 

D. Vectorize the raster mosaic 
a. Tool: Raster to polygon 

i. Input: raster mosaic 
ii. Field: Value 

iii. Uncheck simplify polygons 
E. Prepare the new vector so it can be used as a raster input:  

a. Remove values of 0 from the new polygon:  
i. Select by Attributes where gridcode = 0; delete selection and save edits 

b. Clip the vector to the regional boundary. 
i. Tool: Clip 

1. Input Features: edited Tsunami mosaic vector 
2. Clip Features: regional boundary 

https://earthquake.alaska.edu/sites/all/tsuMap/html/tsunami.html?XQAAAAKtAAAAAAAAAABBqQmmE3eV5EUgH7ZjD94iJiVMK6D0G3SjjnUmUocknjAatqaTOyTn2beKwPgzIBHVGX6KKSL3FdkVPGaSdikDHnMkXcyDxzfc5w1z-SXtX-XtdUwNhYdVuKhlO8oMQM21TP9buDu3p-g6iAbcTfUDRSnHfM_fL3d4UXbXLm1OIipO_vuzX4A
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c. Merge the vector with the regional boundary to create values of 0 throughout the entire 
region where there is no tsunami data  

i. Tool: Merge 
1. Input Datasets: clipped tsunami mosaic, regional boundary 

F. Rasterize the merged tsunami and regional boundary vector:  
a. Tool: Polygon to Raster 

i. Input Features: merged tsunami and regional boundary vector 
ii. Value Field: gridcode 

iii. Cell assignment: max area 
iv. Priority field: gridcode 
v. Cell Size: 30 

Water Depth Rank Type Rank Value 

None None 0 

< 1 ft Moderate 3 

1 - 6 ft High 4 

> 6 ft Very High 5 

C.6 Calculating the Threat Index 
The Threat Index was clipped to the shoreline boundary created by NEMAC and classified into 10 classes 

to multiply with the Asset Index and ultimately create the Community Exposure Index. Below is the 

classification that was used for the Alaska Threat Index.  

Alaska Threat Index Distribution 

Threat 
Index 
Break 
Value 

0 1 2 3 4 5 6 7 8 9 - 20 

Final Rank 
Value 

1 2 3 4 5 6 7 8 9 10 
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D. Detailed Methodology: Community Asset Index 

D.1 Create the Social Vulnerability Input 

Prepare the data for the analysis: 

A. Denali Commission’s annual Distressed Communities report: 
a. Use the most recent Distressed Communities Report to give the community footprints a 

1 (“distressed”) or 0 (“not distressed”); (see Appendix C.2 Create the Soil Erodibility 
Input for detailed methods on the creation of the community footprints layer) 

i. Add a rank field: right click layer in the table of contents > Attribute Table > 
+Add 

1. Name: Rank; Type: short > Save 
ii. Either use Field Calculator or edit the Attribute Table to give the correct values 

to the community footprints 
B. EPA EJSCREEN data (or other suitable social vulnerability dataset): 

a. Clip the EJSCREEN_StatePct feature class (from the downloaded 
EJSCREEN_StatePctEJSCREEN_YEAR_StatePctile.gdb) to the region, selecting only the 
relevant vulnerability index field VULEOPCT (Demographic Index based on 2 factors, % 
low-income and % minority)  

b. Project the data to match the region 

Prepare the analysis area:  

C. Using the building footprints for the region, create centroids to represent areas where people 
live 

a. Data management tools > Features > Feature to Point 
i. Leave “inside” unchecked (uses the representative center of an input feature as 

its output point location) 
D. Create Hexagons for the region 

a. Data Management toolbox > Sampling toolset > Generate Tessellation (Data 
Management) 

i. Extent: set to regional boundary 
ii. Shape type: Hexagon 

iii. Size: 18.5 acres (Note: this size may differ across regions) 
iv. Spatial reference: varies by region 

b. The output generated will cover the entire regional extent, including areas that are not 
in the regional boundary. For the next step, there are two options before proceeding: 

i. Select by location where hexagons intersect the regional boundary 
1. Option 1: export the selected features to a new feature class 
2. Option 2: with the features selected, run the tool in the next step. The 

output of that tool will only include the selected features. 
E. Select by location where hexagons intersect all community footprints, regardless of distress. Run 

another Select by Location, choose “Add to current selection”, and select hexagons that also 
intersect building points. Export the selections as one layer. 

F. Summarize EJSCREEN in the hexagons throughout the region 
a. Select by location where the community footprints hexagon layer from the step above 

intersects the building points. Add a search distance of 300m (the approximate width of 
one of the hexagons). 

https://www.denali.gov/2019-distressed-communities-report/
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b. Summarize Within:  
i. Input: Community Footprints Hexagon layer (with selected features) 
ii. Input Summary Features: EJSCREEN 

iii. Check: Keep all input polygons 
iv. Summary Fields: VULEOPCT; Statistic: Mean 
v. Uncheck: Add shape summary attributes 

G. Add the Distressed Communities information to the summarized hexagons.  
a. Select by attributes where distressed communities = 1  
b. Select by Location where output hexagons intersect the selected distressed 

communities layer. Add a search distance of 300m.  
i. Add a field to the hexagon layer and calculate based on this selected attribute  

1. Name: Distressed; Type: Short 
2. Selected Features = 1 (“yes” distressed); reverse selection and make 

sure any “NULL” values are 0 
H. Distribute the averaged social vulnerability in a way that best represents these data, see table 

below for the distribution used in Alaska 
a. Exclude values and classify data  

i. Right click layer in the Table of Contents > Properties > Symbology > Quantities 
(Graduated colors) > Classify… > Exclusion… 

1. “Mean Social Vulnerability” = [value] 
ii. Continue to distribute the remainder of the data, checking the map to 

determine the best breaks 
I. Rank the data according to the chosen class distribution   

a. Right click layer in Table of Contents > Attribute Table 
i. Add Field > Name: EJ_Rank; Type: Short Integer 

b. Using Select by Attributes, give each class a rank 
i. Where mean social vulnerability <= [lower distribution value] AND mean social 

vulnerability >= [upper distribution value] 
ii. Show selected records 

iii. Right click field Rank > Field Calculator > Rank = 1-2 (reference the table below) 
iv. Repeat for all classes 

J. Add a field to calculate the total rank (combine the EJSCREEN rank values and the Distressed 
Communities presence value) 

a. Add Field > Name: Tot_Rank; Type: Short 
b. Calculate Field: Distressed + EJ_Rank 

K. Merge the final vector with the regional boundary to create values of 0 where there is no data  
L. Convert new layer from vector to raster: 

a. Conversion Tools > To Raster > Polygon to Raster  
i. Value Field: Tot_Rank 
ii. Cell assignment type: Maximum Area 

iii. Priority field: Tot_Rank 
iv. Cell Size: 30 

M. Shift raster  
a. Data Management > Projections and Transformations > Raster > Shift 

i. Input raster: Social Vulnerability raster 
ii. Shift X & Y coordinates by: 1 (each) 

iii. Input snap raster: varies by region 
N. Clip raster to area of interest for further analysis 
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Percentile EJSCREEN Value Rank Value 

 <= 50th ≤0.574 1 

50th - 90th ≤0.906 2 

D.2 Create the Critical Infrastructure Input 

A. Prepare data: 
a. Check to make sure points are in line with community maps and/or other sources. Move 

points in an edit session if necessary. 
B. Buffer and Rank the point data after quality control: 

a. Buffer the facilities using the table below. These are the building “footprints”. 
i. Geoprocessing > Buffer > Method: Planar 

b. Rank the buffered points 
i. Open attribute table > Add field > “Rank”, Type:Short Integer  
ii. Right click new rank field > Calculate Field > Rank = ‘5’ 

c. Merge the buffered feature layers to create a final building “footprints” layer 
i. Geoprocessing > Merge 

C. Expand resulting feature to cover entire region to create values of 0 where there are no critical 
facilities on the landscape  

a. Merge facility feature classes with the regional boundary in the following order: 
boundary, parcel, footprint  

i. Geoprocessing > Merge 
D. Convert merged layer from vector to raster: 

a. Conversion Tools > To Raster > Polygon to Raster  
b. Value Field: Rank 
c. Cell assignment type: Maximum Area 
d. Priority field: Rank 
e. Cell Size: 30  

E. Shift raster  
a. Data Management > Projections and Transformations > Raster > Shift  
b. Shift X & Y coordinates by: 1 (each) 
c. Input snap raster: varies by region 
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Input Buffer Size (meters; method: planar; dissolve type: NONE) 

FM Transmission Towers 10 

Water Distribution Points 20 

Wastewater Treatment Plants 20 

Power Plants 20 

Microwave Towers 10 

Petroleum Terminals 100 

Petroleum Refineries 100 

Landfills 20 

Bulk Fuel Storage 20 

Bridges 100 

D.3 Create the Critical Facilities Input 

A. Prepare the data: 
d. Check to make sure points are in line with community maps and/or other sources. Move 

points in an edit session if necessary. 
B. Buffer and Rank the point data after quality control: 

a. Buffer the facilities using the table below. These are the building “footprints” 
i. Geoprocessing > Buffer > Method: Planar 

Facility Type Buffer Amount 

Post Office 20m 

Public Safety 30m 

Medical, Schools, Fire Departments 50m 

b. Rank the buffered points 
i. Open attribute table > Add field > “Rank”, Type:Short Integer  
ii. Right click new rank field > Calculate Field > Rank = ‘5’ 

c. Merge the three layers to create a final building “footprints” layer 
i. Geoprocessing > Merge 

C. Expand resulting feature to cover entire regional boundary to create values of 0 where there are 
no critical facilities on the landscape  

a. Merge facility feature classes with the regional boundary in the following order: 
boundary, parcel, footprint  

i. Geoprocessing > Merge 
D. Convert merged layer from vector to raster: 

a. Conversion Tools > To Raster > Polygon to Raster  
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b. Value Field: Rank 
c. Cell assignment type: Maximum Area 
d. Priority field: Rank 
e. Cell Size: varies by region  

E. Shift raster  
a. Data Management > Projections and Transformations > Raster > Shift  
b. Shift X & Y coordinates by: 1 (each) 
c. Input snap raster: varies by region 

D.4 Create the Critical Transportation Input 

A. Download all input data and prepare data:  
a. Clip to region. 
b. Reproject, if necessary. 

B. Prepare Roads and Rail datasets: 
a. After the initial data preparation, buffer both Roads and Rail 

i. Geoprocessing > Buffer 
1. Input: Roads line features 
2. Output: Roads buffered 
3. Distance: 20 meters 
4. Side type: full 
5. End type: round 
6. Method: planar 
7. Dissolve type: none  

ii. Geoprocessing > Buffer 
1. Input: Rail line features 
2. Output: Rail lines buffered 
3. Distance: 10 meters 
4. Side type: full 
5. End type: round 
6. Method: planar 
7. Dissolve type: none  

b. Add a rank field to both datasets and rank:  
i. Right click layer in table of contents > Open Attribute Table > Add Field 

1. Name: Rank 
2. Type: Short (or Long) 
3. Save the changes in the ribbon at top and close Fields View 

ii. Right click Rank field > Calculate Field 
1. Rank = 5 
2. Close the attribute table and repeat for the other dataset  

C. Prepare Airport Runways dataset: 
a. Buffer airport runways dataset: 

i. Geoprocessing > Buffer 
1. Input: Runways line features 
2. Output: Runways buffered 
3. Distance: 30 meters 
4. Side type: full 
5. End type: round 
6. Method: planar 
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7. Dissolve type: none 
b. Add a rank field and rank:  

i. Right click layer in table of contents > Open Attribute Table > Add Field 
1. Name: Rank 
2. Type: Short (or Long) 
3. Save the changes in the ribbon at top and close Fields View 

ii. Right click Rank field >  Calculate Field 
1. Rank = 5 

D. Prepare Ferry Terminals, Ports, and Harbors dataset: 
a. Merge ferry terminals, ports, and harbors into a single dataset 
b. Buffer the combined dataset: 

i. Geoprocessing > Buffer 
1. Input: Ferry terminals, ports, and harbors features 
2. Output: Ferry terminals, ports, harbors buffered 
3. Distance: 100 meters 

a. Side type: full 
b. End type: round 
c. Method: planar 
d. Dissolve type: none 

c. Add a rank field and rank:  
i. Right click layer in table of contents > Open Attribute Table > Add Field 

1. Name: Rank 
2. Type: Short (or Long) 
3. Save the changes in the ribbon at top and close Fields View 

ii. Right click Rank field >  Calculate Field 
1. Rank = 5 

E. Merge resulting features into one Transportation Infrastructure dataset.  
a. Geoprocessing > Merge 

i. Inputs: Rail, Roads, Runways, and Ferry Terminals, Ports, and Harbors. 
F. Expand resulting merged features to cover the entire regional boundary to create values of 0 

where there is no transportation infrastructure on the landscape  
a. Merge transportation feature class with the regional boundary: 

i. Geoprocessing > Merge 
b. If using a file geodatabase, ensure that any “NULL” values are changed to 0:  

i. In Attribute Table > Select by Attributes > Where Rank IS NULL 
ii. Right click Rank field > Calculate Field  

1. Rank = 0 
iii. Clear selected features 

G. Convert merged layers from vector to raster: 
a. Conversion Tools > To Raster > Polygon to Raster  
b. Value Field: Rank 
c. Cell assignment type: Maximum Area 
d. Priority field: Rank 
e. Cell Size: 30  

H. Shift raster  
a. Data Management > Projections and Transformations > Raster > Shift  
b. Shift X & Y coordinates by: 1 (each) 
c. Input snap raster: 30 
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D.5 Combining the Community Asset Input Variables 

Similar to the Threat Index, the Community Asset Index is a composite dataset that brings multiple data 
layers together to identify areas of the landscape that contain densities of assets. The Community Asset 
Index was clipped to the shoreline boundary and classified into 10 classes in order to multiply them and 
ultimately create the Community Exposure Index. Below is the classification that was used for the Alaska 
Community Asset Index.  

Alaska Community Asset Index Distribution 

Asset 
Index 
Break 
Value 

0 1 2 3 4 - 5 6 7 8 9 - 11 12 - 18 

Final Rank 
Value 1 2 3 4 5 6 7 8 9 10 

E. Detailed Methodology: Community Exposure Index 

After classifying both the Threat and Community Asset Indices into 10 classes each, they were multiplied 
to create the Community Exposure Index. Exposure is the overlap of community assets and flood 
threats. As this multiplication results in a final index with values from 1-100, the Community Exposure 
Index was further classified to make it easier to work with and understand the results. The distribution 
used for the Community Exposure Index in Alaska is shown below.  

Alaska Community Exposure Index Distribution 

Exposure 
Index 
Break 
Value 

1 2 3 4 5 6 7 - 21 22 - 35 36 - 59 60 - 100 

Final Rank 
Value 1 2 3 4 5 6 7 8 9 10 
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F. Detailed Methodology: Fish and Wildlife Index 

The Terrestrial Index and the Aquatic Index were calculated as the sum of species distribution inputs for 
species shown in the species list for each index. Species distribution inputs came from multiple sources, 
including the Alaska Gap Analysis Project (for terrestrial vertebrates), designated Essential Fish Habitat, 
and the Anadromous Waters Catalog, among others (see Appendix B.3 and B.4). Species distribution 
inputs were summed inside species groups, and then the sum of distributions inside each species group 
was reclassified with a quantile distribution to be in the set {0, 1, 2, 3, 4}. In the reclassified species 
group raster, areas of primary habitat have the value 4, while all other areas have the value 0 (no 
species occupy that pixel) or 1, 2, 3, corresponding to low, medium, and high species richness occupying 
that pixel. See more detailed methods below for the definition of primary habitat in each index. The 
unclassified Terrestrial Index was then calculated as the sum of classified species groups rasters for 
terrestrial species groups and Important Bird Areas; the unclassified Aquatic Index was calculated as the 
sum of classified species groups rasters for aquatic species groups, including marine habitat classes such 
as kelp. Finally, each sub-index was reclassified using a quantile distribution and 10 classes to calculate 
the final Terrestrial or Aquatic Index. 
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F.1 Species Included in the Terrestrial Index 

The following table provides a list of species included in the Terrestrial Index organized by taxonomic 
group. All species included are species of greatest conservation concern in the Alaska Wildlife Action 
Plan (ADFG 2015), species listed under the U.S. Endangered Species Act (denoted with asterisk), and/or 
additional subsistence resources with a minimum of 40 harvest records from 1990-2015. 

Species of Greatest Conservation Concern 

Birds 

Raptors 
Rough-legged hawk (Buteo lagopus) 
Bald eagle (Haliaeetus leucocephalus) 
Golden eagle (Aquila chrysaetos canadensis) 
Gyrfalcon (Falco rusticolus) 
Peregrine falcon (Falco peregrinus) 
Boreal owl (Aegolius funereus) 
Queen Charlotte goshawk (Accipiter gentilis laingi) 
American kestrel (Falco sparverius) 
Northern harrier (Circus cyaneus) 
Short-eared owl (Asio flammeus flammeus) 
Great gray owl (Strix nebulosa) 
Northern hawk owl (Surnia ulula) 
Western screech-owl (Megascops kennicottii) 
Snowy owl (Bubo scandiacus) 

Kingfishers and Woodpeckers 
Hairy woodpecker (Picoides villosus sitkensis) 
Downy woodpecker (Picoides pubescens glacialis) 
Black-backed woodpecker (Picoides acticus) 
Northern flicker (Colaptes auratus luteus) 
Red-breasted sapsucker (Sphyrapicus ruber) 
American three-toed woodpecker (Picoides 
dorsalis) 

Swifts and Hummingbirds 
Rufous hummingbird (Selasphorus rufus) 
Black swift (Cypseloides niger borealis) 

Larks, Crows, and Jays 
Gray jay (Perisoreus canadensis pacificus) 
Steller's jay (Cyanocitta stelleri) 
Common raven (Corvus corax kamtschaticus) 
Horned lark (Eremophila alpestris arcticola) 

Nuthatches, Chickadees, and Swallows 
Bank swallow (Riparia riparia) 
Barn swallow (Hirundo rustica) 
Tree swallow (Tachycineta bicolor) 
Black-capped chickadee (Poecile atricapillus) 
Chestnut-backed chickadee (Poecile rufescens) 
Boreal chickadee (Poecile hudsonicus) 
Gray-headed chickadee (Poecile cincts lathami) 
Northern shrike (Lanius excubitor) 

 

Kinglets, Creepers, Flycatchers, and Wrens 
Ruby-crowned kinglet (Regulus calendula grinnelli) 
Golden-crowned kinglet (Regulus satrapa) 
Olive-sided flycatcher (Contopus cooperi) 
Pacific wren (Troglodytes pacificus) 
Alder flycatcher (Empidonax alnorum) 
Western wood-pewee (Contopus sordidulus) 
Brown creeper (Certhia americana) 
Pacific-slope flycatcher (Empidonax difficilis) 
Bluethroat (Luscinia svecica) 
Northern wheatear (Oenanthe oenanthe oenanthe) 

Thrushes 
Swainson's thrush (Catharus ustulatus) 
Hermit thrush (Catharus guttatus) 
Varied thrush (Ixoreus naevius) 

Waxwings, Pipits, and Warblers 
Bohemian waxwing (Bombycilla garrulus) 
Blackpoll warbler (Setophaga striata) 
American pipit (Anthus rubescens) 
Arctic warbler (Phylloscopus borealis) 
Orange-crowned warbler (Oreothlypis celata) 
MacGillivray's warbler (Geothlypis tolmiei) 
Common yellowthroat (Geothlypis trichas) 
Yellow warbler (Dendroica petechia) 
Townsend's warbler (Setophaga townsendi) 
American redstart (Setophaga ruticilla) 
Wilson’s warbler (Wilsonia pusilla) 

Longspurs, Buntings, and Sparrows 
Lapland longspur (Calcarius lapponicus alascensis) 
Smith's longspur (Calcarius pictus) 
McKay's bunting (Plectrophenax hyperboreus) 
Chipping sparrow (Spizella passerina) 
Savannah sparrow (Passerculus sandwichensis) 
Golden-crowned sparrow (Zonotrichia atricapilla) 
White-crowned sparrow (Zonotrichia leucophrys) 
Snow bunting (Plectrophenax nivalis) 
American tree sparrow (Spizella arborea) 
Lincoln's sparrow (Melospiza lincolnii) 
Dark-eyed junco (Junco hyemalis oreganus) 
Fox sparrow (Passerella iliaca) 
Song sparrow (Melospiza melodia)  
Aleutian song sparrow (Melospiza melodia sanaka) 
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Birds (continued) 

Blackbirds, Finches, Crossbills, Grosbeaks, and 
Redpoll 
Red-winged blackbird (Agelaius phoeniceus) 
Rusty blackbird (Euphagus carolinus carolinus) 
White-winged crossbill (Loxia leucoptera) 
Pine siskin (Spinus pinus) 
Common redpoll (Acanthis flammea) 
Hoary redpoll (Acanthis hornemanni) 
Pine grosbeak (Pinicola enucleator flammula) 
Gray-crowned rosy finch (Leucosticte tephrocotis) 

Ducks, Geese, and Swans 
Trumpeter swan (Cygnus buccinator) 
Emperor goose (Chen canagica) 
Lesser scaup (Aythya affinis) 
Common eider (Pacific population) (Somateria 
mollissima) 
Steller's eider (Polysticta stelleri)* 
Aleutian cackling goose (Branta hutchinsii 
leucopareia) 
Black scoter (Melanitta americana) 
White-fronted goose (Anser albifrons elgasi) 
Greater white-fronted goose (Anser albifrons) 
Spectacled eider (Somateria fischeri)* 
King eider (W. Arctic) (Somateria spectabilis) 
White-winged scoter (Melanitta deglandi) 
Pacific black scoter (Melanitta americana) 
Long-tailed duck (Clangula hyemalis) 
Black brant (Branta bernicla nigricans) 
Canada goose (Branta canadensis occidentalis) 
Taverner’s cackling goose (Branta hutchinsii 
taverneri) 

Loons and Grebes 
Yellow-billed loon (Gavia adamsii) 
Arctic loon (Gavia arctica)  
Red-throated loon (Gavia stellata) 

Procellarids 
Laysan albatross (Phoebastria immutabilis) 
Black-footed albatross (Phoebastria nigripes) 
Short-tailed albatross (Phoebastria albatrus)* 
Northern fulmar (Fulmarus glacialis) 
Fork-tailed storm-petrel (Hydrobates furcatus) 

Cormorants 
Red-faced cormorant (Phalacrocorax urile) 
Pelagic cormorant (Phalacrocorax pelagicus) 

 

 

Oystercatchers and Plovers 
Black oystercatcher (Haematopus bachmani) 
American golden plover (Pluvialis dominica) 
Pacific golden plover (Pluvialis fulva) 
Black-bellied plover (Pluvialis squatarola) 
Killdeer (Charadrius vociferus) 

Sandpipers 
Spotted sandpiper (Actitis macularius) 
Upland sandpiper (Bartramia longicauda) 
Whimbrel (Numenius phaeopus hudsonicus) 
Bristle-thighed curlew (Numenius tahitiensis) 
Eskimo curlew (Numenius borealis)* 
Bar-tailed godwit (Limosa lapponica baueri) 
Hudsonian godwit (Limosa haemastica) 
Marbled godwit (Limosa fedoa beringea) 
Black turnstone (Arenaria melanocephala) 
Red knot (Calidris canutus roselaari) 
Red phalarope (Phalaropus fulicarius) 
Long-billed dowitcher (Limnodromus scolopaceus) 
Solitary sandpiper (Tringa solitaria cinnomomea) 
Dunlin (Calidris alpina) 
Sanderling (Calidris alba) 
Rock sandpiper (Calidris ptilocnemis) 
Wandering tattler (Tringa incana) 
Pectoral sandpiper (Calidris melanotos) 
Semipalmated sandpiper (Calidris pusilla) 
Western sandpiper (Calidris mauri) 
Short-billed dowitcher (Limnodromus griseus 
caurinus) 
Lesser yellowlegs (Tringa flavipes) 
Surfbird (Calidris virgata) 
Buff-breasted sandpiper (Calidris subruficollis) 

Auks 
Crested auklet (Aethia cristatella) 
Least auklet (Aethia pusilla) 
Whiskered auklet (Aethia pygmaea) 
Dovekie (Alle alle) 
Kittlitz's murrelet (Brachyramphus brevirostris) 
Marbled murrelet (Brachyramphus marmoratus) 
Ancient murrelet (Synthliboramphus antiquus 
antiquus) 
Pigeon guillemot (Cepphus columba columba) 
Black guillemot (Cepphus grylle) 
Thick-billed murre (Uria lomvia arra) 
Common murre (Uria aalge inornata) 
Tufted puffin (Fratercula cirrhata) 
Horned puffin (Fratercula corniculata) 
Parakeet auk (Aethia psittacula) 
Cassin’s auk (Ptychoramphus aleuticus aleuticus) 
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Birds (continued) 

Gulls, Terns, and Jaegers  
Black-legged kittiwake (Rissa tridactyla) 
Red-legged kittiwake (Rissa brevirostris) 
Mew gull (Larus canus brachyrhynchus) 
Herring gull (Larus smithsonianus) 
Glaucous-winged gull (Larus glaucescens) 
Sabine's gull (Xema sabini) 
Pomarine jaeger (Stercorarius pomarinus) 
Long-tailed jaeger (Stercorarius longicaudus) 
Aleutian tern (Onychoprion aleuticus) 
Glaucous gull (Larus hyperboreus) 

Amphibians 

Roughskin newt (Taricha granulosa) 
Western toad (Anaxyrus boreas) 
Wood frog (Lithobates sylvaticus) 
Northwestern salamander (Ambystoma gracile) 
Long-toed salamander (Ambystoma 
macrodactylum) 

Terrestrial Mammals 

Hares and Pikas 
Snowshoe hare (Lepus americanus) 
Alaska hare (Lepus othus) 
Collared pika (Ochotona collaris) 

Bats 
Keen's long-eared bat (Myotis keenii) 
Little brown bat (Myotis lucifugus) 
Long-legged myotis (Myotis volans) 
California myotis (Myotis californicus) 
Silver-haired bat (Lasionycteris noctivagans) 

Felids and Canids 
Arctic fox (Vulpes lagopus) 
Alexander Archipelago wolf (Canis lupus ligoni) 
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Subsistence Species (additional species not included above) 

Felids and Canids 
Wolf (Canis lupus) 
Red fox (Vulpes vulpes) 
Coyote (Canis latrans) 
Canadian lynx (Lynx canadensis) 

Other Furbearers 
American beaver (Castor canadensis) 
Ermine (Mustela erminea) 
Woodchuck (Marmota monax) 
American marten (Martes americana) 
American mink (Neovison vison) 
Muskrat (Ondatra zibethicus) 
North American porcupine (Erethizon dorsatum) 
Least weasel (Mustela nivalis) 
Wolverine (Gulo gulo) 

Other Large Land Mammals 
Caribou (Rangifer tarandus) 
Dalls sheep (Ovis dalli) 
Muskox (Ovibos moschatus) 
Black bear (Ursus americanus) 
Elk (Cervus canadensis) 
Mountain goat (Oreamnos americanus) 
Moose (Alces americanus) 
Brown bear (Ursus arctos) 

Pheasants and Grouse 
Rock ptarmigan (Lagopus muta) 
Ruffed grouse (Bonasa umbellus) 
Sharp-tailed grouse (Tympanuchus phasianellus) 
Spruce grouse (Falcipennis canadensis) 
Willow ptarmigan (Lagopus lagopus) 

 
 

Ducks, Geese, Swans 
Canvasback (Aythya valisineria) 
Common goldeneye (Bucephala clangula) 
Common merganser (Mergus merganser) 
Red-Breasted merganser (Mergus serrator) 
American wigeon (Anas americana) 
Bufflehead (Bucephala albeola) 
Green-winged teal (Anas crecca) 
Blue-winged teal (Anas discors) 
Long-tailed duck (Clangula hyemalis) 
Snow goose (Chen caerulescens) 
Tundra swan (Cygnus columbianus) 
Gadwall (Anas strepera) 
Harlequin duck (Histrionicus histrionicus) 
Mallard (Anas platyrhynchos) 
Northern pintail (Anas acuta) 
Northern shoveler (Anas clypeata) 
Surf scoter (Melanitta perspicillata) 

Sandpipers 
Common snipe (Gallinago gallinago) 

Terns 
Arctic tern (Sterna paradisaea) 

Cranes 

Sandhill crane (Grus canadensis) 
 

F.2 Calculating the Terrestrial Index  

Process “Primary” habitat data 

For Terrestrial Species, federally designated critical habitat is used to define primary habitat in the 
Assessment. Process as follows: 

A. Select by attributes for the species or group of species desired  
B. With species selected, clip to the regional boundary 
C. Rank the clipped habitat dataset:  

a. Right click layer in Table of Contents > Attribute Table 
b. Add a field:  

i. Name: Rank; Type: short 
ii. Save the changes and close Fields view 

c. Right click Rank field > Calculate Field > Rank = 100 
D. Merge the ranked habitat dataset to the regional boundary  
E. Rasterize the merged habitat and regional boundary dataset  



81 
 

a. Tool: Polygon to Raster 
i. Input: merged habitat and regional boundary 
ii. Value field: rank 

iii. Cell assignment type: max area 
iv. Priority field: rank 
v. Cell Size: 30 

Repeat for each individual species or group of species  

Process the GAP distribution rasters 

Note: this process will also be used for any marine mammals that have Alaska Gap Analysis Project data 
available. Marine mammals will be included in the Aquatic Index (below). 

F. Select only where VALUE = 1 in the raw GAP rasters:  
a. Tool: Extract by Attributes 

i. Value is equal to 1 
ii. Output: GAP_Rasters/Species_Name_GAP_Distribution.tif 

1. Note: Remember to add the “.tif” extension manually when the output 
file name is entered. The tool does not do this automatically as it does 
for vectors.  

iii. Important: Be sure to set output coordinates in environments to WKID=3338 for 
Alaska 

G. Change the output raster to vector:  
a. Tools: Raster to Polygon 

i. Field: Value 
ii. Uncheck simplify polygons 

iii. Output: GAP_Vectors/Species_Name_GAP_Distribution (shp) 
H. Clip the output vector to the region:  

a. Tools: Clip 
i. Input: GAP Distribution vector 

ii. Output: GAP_Vectors/Species_Name_GAP_Distribution_clip (shp) 
I. Merge the vector with the region:  

a. Tools: Merge 
i. Input: Clipped GAP Distribution Vector, 20-meter depth boundary 

ii. Output: GAP_Vectors/Final/Species_Name_RegMerge (shp) 
J. Rasterize the newly merged distribution vector 

a. Tools: Polygon to Raster 
i. Input: merged vectors 
ii. Value Field: grid code 

iii. Output: Raster_Inputs/Species_Name.tif 
1. Note: Remember to add the “.tif” extension manually when the output 

file name is entered. The tool does not do this automatically as it does 
for vectors. 

iv. Cell Assignment: max area 
v. Priority field: grid code 
vi. Cell Size: 30 
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Process other distribution or range data (any other sources) 

K. Clip the data to the region 
a. Output: Species_Name_SOURCE_clip.shp 
b. Important: Be sure to set the coordinate system in the processing environments to 

WKID=3338 
L. Rank the data with a “1” to be added in:  

a. Add Field: Name: Rank; Type: Short 
b. Calculate Field: Rank = 1 

M. Merge with the region 
a. Output: Species_Name_SOURCE_RegMerge.shp 

N. Rasterize the output:  
a. Value Field: Rank 
b. Output: Species_Name.tif 
c. Cell Assignment: max area 
d. Priority field: rank 
e. Cell Size: 30 

Combine species group data 

At this point, any range, distribution, or primary habitat data identified for each species should be fully 
processed and ready for use. Use the raster calculator to add together raster data for each species group 
to create a single raster, excluding any “primary” habitat data. For example, a pixel that appears in the 
range/distribution maps for 10 individual species within a species group would have a value of 10. This 
summed raster is then reclassified into 4 classes. In Alaska, species groups for birds are subdivided into 
two larger groups: land birds and seabirds. 

O. Use a quantile distribution and 4 classes, making sure that values of 0 remain 0 (in their own 
class). Reclassify using this distribution.  

P. Use the raster calculator to add any primary habitat for the species group to the reclassified 
raster. 

Q. Reclassify the output so that any values 0-3 retain their value while any values 100+ (i.e., 
primary habitat plus any overlapping species distribution or range data) become a 4. (If a species 
group does not have any critical habitat data, or “primary data” in this stage, PADUS and state-
level data identifying managed wildlife areas will be used to incorporate secondary and tertiary 
habitat in the Fish and Wildlife Index calculation later.) 

Important Bird Areas 

These data are prepared similarly to other datasets:  
R. Clip to the region, be sure to set the coordinates in the processing environments to 3338  
S. Rank the clipped IBA data:  

a. Open Attribute Table > Add Field:  
i. Name: Rank; Type: short 
ii. Save and close Fields view  

b. Right click Rank field > Calculate Field > Rank = 1 
T. Merge ranked IBA data with the regional boundary 
U. Rasterize the merged IBA and regional boundary 

a. Tool: Polygon to Raster 
i. Input: merged IBA and regional boundary 
ii. Value field: rank 
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iii. Cell assignment type: max area 
iv. Priority field: rank 
v. Cell Size: 30 

Species group rasters are added together with Important Bird Areas and then reclassified. The 
distribution for the Alaska Terrestrial Index is displayed below. The final rank value was determined 
using a quantile distribution and was then combined with the Aquatic Index to create the Fish and 
Wildlife Index. 

Alaska Terrestrial Index Distribution 

Terrestrial
Index 
Break 
Value 

0 - 1 2 3 4 5 6 7 8 9 10 - 13 

Final Rank 
Value 1 2 3 4 5 6 7 8 9 10 
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F.3 Species Included in the Aquatic Index 

The following table provides a list of species included in the Aquatic Index organized by taxonomic 
group. All species included are species of greatest conservation concern in the Alaska Wildlife Action 
Plan (ADFG 2015), species with designated Essential Fish Habitat, species also listed under the U.S. 
Endangered Species Act (denoted with asterisk), and/or additional subsistence resources with a 

minimum of 40 harvest records from 1990 - 2015. 

Essential Fish Habitat 

Fishery Management Plan21 for Salmon 
Fisheries in the EEZ off Alaska 
Pink salmon (Oncorhynchus gorbuscha) 
Chum salmon (Oncorhynchus keta) 
Coho salmon (Oncorhynchus kisutch) 
Sockeye salmon (Oncorhynchus nerka) 
Chinook salmon (Oncorhynchus tshawytscha) 

Fishery Management Plan for Bering 
Sea/Aleutian Islands King & Tanner Crabs 
Tanner crab (Chionoecetes bairdi) 
Snow crab (Chionoecetes opilio) 
Golden king crab (Lithodes aequispinus) 
Red king crab (Paralithodes camtschaticus) 
Blue king crab (Paralithodes platypus) 

Fishery Management Plan for Fish Resources 
of the Arctic Management Area 
Arctic cod (Boreogadus saida) 
Saffron cod (Eleginus gracilis) 
Snow crab (Chionoecetes opilio) 

Fishery Management Plans for Groundfish (of 
the Gulf of Alaska and/or Bering Sea and 
Aleutian Islands Management Area) 
Sablefish (Anoplopoma fimbria) 
Walleye Pollock (Gadus chalcogrammus) 
Pacific cod (Gadus macrocephalus) 
Atka mackerel (Pleurogrammus monopterygius) 
Kamchatka flounder (Atheresthes evermanni) 
Arrowtooth flounder (Atheresthes stomias) 
Rex sole (Glyptocephalus zachirus) 
Flathead sole (Hippoglossoides elassodon) 
Southern rock sole (Lepidopsetta bilineata) 
Northern rock sole (Lepidopsetta polyxystra) 
Yellowfin sole (Limanda aspera) 
Dover sole (Solea solea) 
Alaska plaice (Pleuronectes quadrituberculatus) 
Greenland turbot (Reinhardtius hippoglossoides) 
 

 

Shortspine thornyhead rockfish (Sebastolobus 
alascanus) 
Longspine thornyhead rockfish (Sebastolobus 
altivelis) 
Rougheye rockfish (Sebastes aleutianus) 
Pacific Ocean perch (Sebastes alutus) 
Redbanded rockfish (Sebastes babcocki) 
Shortraker rockfish (Sebastes borealis) 
Silvergray rockfish (Sebastes brevispinis) 
Dark rockfish (Sebastes ciliatus) 
Greenstriped rockfish (Sebastes elongatus) 
Rosethorn rockfish (Sebastes helvomaculatus) 
Quillback rockfish (Sebastes maliger) 
Black rockfish (Sebastes melanops) 
Blackspotted rockfish (Sebastes melanostictus) 
Northern rockfish (Sebastes polyspinis) 
Redstripe rockfish (Sebastes proriger) 
Yelloweye rockfish (Sebastes ruberrimus) 
Dusky rockfish (Sebastes variabilis) 
Harlequin rockfish (Sebastes variegatus) 
Pygmy rockfish (Sebastes wilsoni) 
Sharpchin rockfish (Sebastes zacentrus) 
Aleutian skate (Bathyraja aleutica) 
Bering skate (Bathyraja interrupta) 
Alaska skate (Bathyraja parmifera) 
Mud skate (Bathyraja taranetzi) 
Yellow Irish lord (Hemilepidotus jordani) 
Bigmouth sculpin (Hemitripterus bolini) 
Great sculpin (Myoxocephalus 
polyacanthocephalus) 
Giant octopus (Enteroctopus dofleini) 

 

  

 
21 Alaska Management Area Fishery Management Plans: https://www.fisheries.noaa.gov/rules-and-announcements/plans-and-
agreements?title=&management_area%5BAlaska%5D=Alaska&sort_by=title  

https://www.fisheries.noaa.gov/rules-and-announcements/plans-and-agreements?title=&management_area%5BAlaska%5D=Alaska&sort_by=title
https://www.fisheries.noaa.gov/rules-and-announcements/plans-and-agreements?title=&management_area%5BAlaska%5D=Alaska&sort_by=title
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Species of Greatest Conservation Concern 

Fishes 

Trout and Steelhead 
Rainbow/steelhead trout (Oncorhynchus mykiss) 
Coastal cutthroat trout (Oncorhynchus clarki clarki) 
Lake trout (Salvelinus namaycush) 

Pike, Char, and Grayling 
Arctic grayling (Thymallus arcticus) 
Dolly Varden (Salvelinus malma) 
Arctic char (Salvelinus alpinus) 
Northern pike (Esox Lusius) 

Lamprey 
Alaskan brook lamprey (Lethenteron alaskense) 
Western river lamprey (Lampetra ayresii) 
Arctic lamprey (Lethenteron camtschatica) 
Pacific lamprey (Entosphenus tridentate) 

Forage Fish 
Pond smelt (Hypomesus olidus) 
Surf smelt (Hypomesus pretiosus) 
Rainbow smelt (Osmerus mordax) 
Longfin smelt (Spirinchus thaleichthys) 
Trout perch (Percopsis omiscomaycus) 
Capelin (Mallotus villosus) 
Eulachon (Thaleichthys pacificus) 
Pacific herring (Clupea pallasii) 
Pacific sand lance (Ammodytes hexapterus) 

Cod and Mackerel 
Pacific tomcod (Microgadus proximus) 
Burbot (Lota lota) 
Lingcod (Ophiodon elongates) 

Whitefish, Blackfish, and Inconnu 
Humpback whitefish (Coregonus pidschian) 
Alaska blackfish (Dallia pectoralis) 
Broad whitefish (Cregonus nasus) 
Pygmy whitefish (Prosopium coulterii) 
Round whitefish (Prosopium cylindraceum) 
Inconnu (Stenodus leucichthys) 
Least cisco (Coregonus sardinella) 
Arctic cisco (Coregonus autumnalis autumnalis) 
Bering cisco (Coregonus laurettae) 
Least cisco (Coregonus sardinella) 

 

Rockfish 
Brown rockfish (Sebastes auriculatus) 
Copper rockfish (Sebastes caurinus) 
China rockfish (Sebastes nebulosus) 
Bocaccio (Sebastes paucispinis) 

Sharks 
Salmon shark (Lamna ditropis) 

Invertebrates 

Abalone 
Pinto abalone (Haliotis kamtschatkana) 

Squid 
Minimal armhook squid (Berryteuthis anonychus) 
Giant Pacific octopus (Enteroctopus dofleini) 

Marine Mammals 

Otters 

Sea otter (Northern) (Enhydra lutris kenyoni)* 

Walrus and Sea Lions 
Pacific walrus (Odobenus rosmarus) 
Steller sea lion, Western DPS (Eumetopias jubatus)* 
Northern fur seal (Callorhinus ursinus) 

Seals 
Bearded seal, Beringia DPS (Erignathus barbatus 
nauticus)* 
Ribbon seal (Histriophoca fasciata) 
Arctic ringed seal (Pusa hispida hispida)* 
Spotted seal (Phoca largha) 
Pacific harbor seal (Phoca vitulina richardii) 

Baleen Whales 
Gray whale, Eastern North Pacific DPS (Eschrichtius 
robustus)* 
Bowhead (Balaena mysticetus)* 
North Pacific right whale (Eubalaena japonica)* 
Humpback whale, Western North Pacific and 
Mexico DPS (Megaptera novaeangliae)* 

Toothed Whales 
Killer whale (Orcinus orca) 
Beluga whale, Cook Inlet DPS (Delphinapterus 
leucas)* 

Porpoises 
Harbor porpoise (Phocoena phocoena) 

Bears 
Polar Bear (Ursus maritimus) 
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Subsistence Species (additional species not included above) 

Crabs 
Dungeness crab (Metacarcinus magister) 

Cockles, Scallops, Clams, Mussels, and Abalone 
Razor clam (Siliqua patula) 
Cockle (Clinocardium nuttalii) 
Blue mussel (Mytilus trossulus) 

 

 

F.4 Calculating the Aquatic Index  

Process Anadromous Waters Catalog data 

A. Export each species from the Anadromous Water Catalog and clip to the Alaska Assessment 
regional boundary, remembering to change the coordinate system in the geoprocessing 
environments to 3338.  

B. Do not sort the species by any lifestage, rather each species present receives a presence value 
(e.g., a species attributed as “present” and “spawning” for one stream or lake would only be 
counted once)  

C. Buffer the streams data by 35 meters. This needs to be done so that the data for each species 
can be merged together 

D. If there is data in the “lakes” and “streams” datasets for one species, merge the buffered 
streams and lakes datasets together to create one dataset for each species 

Essential Fish Habitat  

Species-specific EFH data serve as “primary” habitat for species of conservation concern within species 
groups. There are no Habitat Areas of Particular Concern within the 20-m depth boundary.  

Process as follows: 
A. Select by attributes for the species or group of species desired  
B. With species selected, clip to the Alaska Assessment regional boundary  
C. Rank the clipped EFH dataset:  

a. Right click layer in Table of Contents > Attribute Table 
b. Add a field:  

i. Name: Rank; Type: short 
ii. Save the changes and close Fields view 

c. Right click Rank field > Calculate Field > Rank = 10 
D. Merge the ranked EFH dataset to the regional boundary  
E. Rasterize the merged EFH and regional boundary dataset 

a. Tool: Polygon to Raster 
i. Input: merged EFH and regional boundary 
ii. Value field: rank 

iii. Cell assignment type: max area 
iv. Priority field: rank 
v. Cell Size: 30 

F. Repeat for each individual species or group of species  
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Aquatic habitat data from Alaska ShoreZone 

Alaska ShoreZone biobands data were used to generate nearshore marine habitat inputs. The 
“patchy/continuous” codes pertaining to each bioband listed below were used to identify areas of low 
or high coverage of the habitat class. Because these data are originally in polyline format, buffers were 
applied before converting to raster for inclusion in the aquatic index. 

The habitat types, and their associated bioband codes, that were extracted from Alaska ShoreZone 
were: Dragon Kelp (ALF), Giant Kelp (MAC), Bull Kelp (NER), Eelgrass (ZOS), Surfgrass (SUR), Alaria (ALA), 
Soft Brown Kelp (SBR), Dark Brown Kelp (CHB), and Rockweed (FUC). 

For each habitat type: 
A. Select features with patchy or continuous cover of that habitat type from the Alaska ShoreZone 

data, using the field matching the bioband code 
a. Select by attributes where <bioband code> includes the values C,P 

B. Buffer the selected features and export to a new layer 
a. Tool: Buffer 

i. Distance: 30m 
C. Calculate rank value for each buffered line segment 

a. Right click layer in Table of Contents > Attribute Table 
b. Add a field:  

i. Name: Rank; Type: short 
ii. Save the changes and close Fields view 

c. Calculate the Rank field according to cover of the bioband: 
i. Where the bioband code has the value C (continuous), Rank = 2 
ii. Where the bioband code has the value P (patchy), Rank = 1 

d. Clip the ranked, buffered dataset to the Alaska Assessment regional boundary 
e. Merge the ranked, buffered dataset with the Alaska Assessment regional boundary 
f. Rasterize the merged habitat and regional boundary dataset 

i. Tool: Polygon to Raster 
1. Input: merged habitat and regional boundary 
2. Value field: rank 
3. Cell assignment type: max area 
4. Priority field: rank 
5. Cell Size: 30 

g. Repeat for each habitat type 

Sum the rasters across habitat types into a single unclassified marine habitat raster. Classify this raster 
using a quantile distribution into the values {0, 1, 2, 3}, ensuring that pixels with value=0 keep this value. 
This will be included in the aquatic index as if it were a species group. 

Combine Species Group Data 

At this point, any range, distribution, or primary habitat data identified for each species should be fully 
processed and ready for use. Use the raster calculator to add together raster data for each species 
group to create a single raster. This will need to be reclassified. 

A. If there is “primary” habitat involved and there are values of 10 or higher, reclass as follows:  
a. Values 0-3 remain the same 
b. Values 10+ should be reclassified to 4 

B. If there is no primary habitat involved and there are values >3, reclass as follows:  
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a. Use a quantile distribution and 4 classes, making sure that values of 0 remain 0 (in their 
own class). Reclassify using this distribution. 

Add the classified species groups rasters together, along with EFH for species not included in the SWAP 
(described below) to create an unclassed Aquatic Index.  

Essential Fish Habitat for species not included in the Alaska Wildlife Action Plan 

Calculate an index that represents the number of species with designated Essential Fish Habitat (EFH), 
for those species not included in the Alaska Wildlife Action Plan (ADFG 2015). This ensures that all 
designated EFH is reflected in the Aquatic Index. 

C. Extract features from the EFH data for species not included in the SWAP, using the species name 
attribute 

D. Generate a raster that gives, for each pixel, the number of species whose designated EFH 
includes that pixel. This is the EFH index. 

E. Reclassify the EFH index into {0, 1, 2, 3} using a quantile distribution and ensuring that pixels 
with unclassed value of 0 retain that value. 

The distribution for the Aquatic Index is displayed below. The final rank value was determined using a 
quantile breaks distribution for the Index and was then combined with the Terrestrial Index to create 
the Fish and Wildlife Index. 

Alaska Aquatic Index Distribution 

Aquatic 
Index 
Break 
Value 

0 1 2 3 - 5 6 - 8 9 - 10 11 - 14 15 - 20 21 - 23 24 - 29 

Final Rank 
Value 1 2 3 4 5 6 7 8 9 10 
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F.5 Calculating the Fish and Wildlife Index 

Protected and Managed Areas 

In Alaska, protected and managed areas are not included as inputs to the Terrestrial Index or Aquatic 
Index, but rather calculated separately to add directly into the Fish and Wildlife Index because they are 
not distinctly aquatic or terrestrial, but likely serve both groups. They are prepared and added in when 
the Aquatic and Terrestrial Indices come together to create the Fish and Wildlife Index. The process for 
preparing both is the same, with the exception of a few selection steps at the beginning. 

Protected Areas with a GAP status of 1 or 2 (“Secondary” and “Tertiary” habitat) 

A. Using the Protected Areas Database (PADUS), extract areas with a GAP status of 1 or 2. The GAP 
Status Code is a measure of management intent to conserve biodiversity. 

a. Select by attributes where GAP Status Code = 1 or 2 
i. Status Code 1: an area having permanent protection from conversion of natural 

land cover and a mandated management plan in operation to maintain a natural 
state within which disturbance events are permitted to proceed without 
interference or are mimicked through management.  

ii. Status Code 2: an area having permanent protection from conversion of natural 
land cover and a mandated management plan in operation to maintain a 
primarily natural state, but which may receive uses or management practices 
that degrade the quality of existing natural communities, including suppression 
of natural disturbance. 

B. With the records selected, clip the dataset to the regional boundary. This will create a clipped 
output of only the selected features.  

C. Remove State Critical Wildlife Areas from the clipped dataset: 
a. Select by attributes where Local Designation = State Critical Wildlife Area 
b. Delete the selected features and save the changes 

D. Rank prepared data 
a. Open Attribute Table and add a Rank field:  

i. Name: Rank; Type: Short 
ii. Save changes and return to attribute table  

b. Right click Rank Field > Calculate Field > Rank = 1 
E. Merge ranked data to the regional boundary 
F. Rasterize the merged protected areas and regional boundary: 

a. Tool: Polygon to Raster 
i. Input: merged PADUS and regional boundary 
ii. Value field: rank 

iii. Cell assignment type: max area 
iv. Priority field: rank 
v. Cell Size: 30 

State Critical Wildlife Areas 

G. Clip the dataset to the regional boundary 
H. Ranked the clipped data 

a. Open Attribute Table and add a Rank field:  
i. Name: Rank; Type: Short 
ii. Save changes and return to attribute table 
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b. Right click Rank field > Calculate Field > Rank = 1 
I. Merge ranked wildlife areas to the regional boundary 
J. Rasterize the merged wildlife areas and regional boundary:  

a. Tool: Polygon to Raster 
i. Input: merged wildlife areas and regional boundary 
ii. Value field: rank 

iii. Cell assignment type: max area 
iv. Priority field: rank 
v. Cell Size: 30 

Below is the distribution for the Alaska Fish and Wildlife Index. The Terrestrial and Aquatic Indices were 
classified into ten classes before they were added together along with the protected and managed areas 
to create the Fish and Wildlife Index. Using a quantile distribution, the Fish and Wildlife Index was 
reclassified into ten classes to allow readers to more easily distinguish values.  

Alaska Fish and Wildlife Index Distribution 

Fish & 
Wildlife 
Index 
Break 
Values 

2 - 4 5 6 7 8 9 10 11 12 13 - 21 

Final 
Rank 
Value 1 2 3 4 5 6 7 8 9 10 
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G. Detailed Methodology: Resilience Hubs 

G.1 Green Infrastructure 

The generation of the Habitat Cores was conducted following the automated processes described in 
Evaluating and Conserving Green Infrastructure Across the Landscape: A Practitioner's Guide, by Karen 
Firehock (February 2015). For this Assessment, the scripts used to automate the processes were 
modified from the original toolbox, titled “Green Infrastructure Center Model for ArcGIS Desktop.” Due 
to this automation, detailed steps for the development of Habitat Cores are not provided. 

Once Habitat Cores are created, apply the Smooth geoprocessing procedure to the Habitat Cores, with a 
100-meter threshold.  

G.2 Selection of Habitat Cores nearest to Community Assets 

As the Green Infrastructure process will result in many Habitat Cores throughout the entirety of the 
region, this step filters out those Cores that are too distant from Community Assets, which are expected 
to provide minimal benefit to resilience-building efforts. The Habitat and Riparian Cores that remain are 
those that are nearest to Community Assets, therefore providing the most potential benefit for 
resilience efforts. 

A. Select all community assets (vector format) that make up the Community Asset Index  
B. Apply a 5-km buffer to the selected assets 
C. Select all Cores that spatially intersect with this 5-km buffer 
D. Export the selected Cores as a new layer 

G.3 Addition of Riparian Corridors and Shorelines 

The National Hydrology Dataset (NHD) ‘flowlines’ feature class was used to identify riparian and 
shoreline Habitat Cores that would have otherwise been excluded from the analysis due to the size 
minimums and other topographical characteristics that are considered in the Green Infrastructure 
methodology. Process as follows: 

E. Select coastline and urban NHD flowlines within a 5-kilometer (3.1-mile) buffer of any 
community asset and merge selections into a single feature class 

a. Clip NHD flowlines to a 5-kilometer (3.1-mile) buffer of any community asset to reduce 
the number of records in the dataset for the selection 

b. Select By Location NHD flowlines representing Alaska’s coastline (FCode = 56600) 
c. Select By Location all streams and rivers within Alaska’s most populated places (parts of 

greater Anchorage area and Juneau) 
i. Select U.S. Census Populated Places (a feature class representing incorporated 

places and U.S. Census Designated Places attributed with population size) where 
population class is greater than or equal to 6 (population >=10,000) 

d. Merge selections into a single feature class 
F. Buffer merged coastal and urban riverine flowlines by a distance of 100 meters (Side Type = Full) 
G. Dissolve buffered flowlines 
H. Erase flowlines that already are covered by a Habitat Core and apply an inverse buffer to mimic 

Habitat Core fragmentation 
a. Use the Erase geoprocessing tool to erase smoothed Habitat Cores from the dissolved 

flowline buffers 

https://www.arcgis.com/home/item.html?id=d653270fb24847deaf65892f1b3c4b6e
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b. Apply an inverse buffer (-10 m, Side Type = Full) to the resulting features to create 
separation between Habitat Cores and flowline buffers 

c. Convert the resulting features to singlepart features using the Multipart to Singlepart 
geoprocessing tool 

I. Calculate the area of each of the resulting singlepart features and filter out fragments 
a. Calculate Geometry Attributes for a new field (Area) where the Area Unit = Acres 
b. Select Layer by Attribute where Area is greater than or equal to 10 acres (10 acres was 

selected to match the minimum area of the Habitat Cores) 
c. Export resulting selection to a new feature class 

J. Merge resulting exported selection with smoothed Habitat Cores 

G.4 Creating a Hexagonal Grid  

With the Habitat Cores merged with the riparian corridors and shorelines, a hexagonal grid is created to 
cover the regional extent: 

K. “Create Grid” tool, and select “Hexagon” as the grid type 
L. Set the grid extent to the shapefile that defines the region  
M. Determine the parameters of the hexagon geometries 

a. 10-acres in area, or, where applicable, set horizontal and vertical spacing to 216.17-
meters 

N. Select hexagons that intersect Cores 
a. Select where the hexagonal features have their centroids contained within a Core (note 

that the hexagonal grid may have to be subdivided so geoprocessing that occurs in 
memory does not exceed available memory. For Alaska, the hexagonal grid was clipped 
to a 50-km buffered regional boundary to greatly reduce the number of hexagon 
features within the feature envelope but over open water and land outside of the 
regional boundary. The clipped hexagonal grid was then subdivided into individual 
feature classes with 500,000 features for geoprocessing, then merged back together 
into a single feature class) 

O. Export selected hexagons as an individual “Grid” layer  

G.5 Ranking Resilience Hubs 

The following steps to score and rank are applicable to both the Habitat Cores and hexagonal grid: 

P. Create a field “hub_id” and use the field calculator to generate a unique ID for each Core or 
“hex_id” for each hexagon.  

Q. To calculate Fish & Wildlife Index scores, perform zonal statistics on the Cores and hexagons 
a. Use Cores as the input layer 
b. Select “Mean” as the statistic to calculate 
c. Select the Fish & Wildlife Index as the input raster 
d. Prepare a field “fw_mean” to contain mean scores 
e. Run zonal statistics 
f. “Fw_mean” now contains the Fish and Wildlife score for each Core and hexagon 

R. Buffer the Cores or hexagonal grid by 1-km 
S. To calculate Community Exposure Index scores, perform zonal statistics on the buffered Cores 

and hexagons 
a. Use buffered Cores or hexagons as the input layer 
b. Select “Mean” as the statistic to calculate 
c. Select the Community Exposure Index as the input raster 
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d. Prepare a field “expbuf_mean” to contain mean scores 
e. Run zonal statistics 
f. “expbuf_mean” now contains the Community Exposure Index score for each buffered 

Core or hexagon 
T. Perform a spatial join to join the “expbuf_mean” scores from the buffered Cores or hexagons to 

the attribute table of the non-buffered Cores or hexagons 
a. Spatial join or “join attributes by field value,” set join parameter to “one-to-one”  
b. Input layer 1 = non-buffered Cores or hexagons, table field to join by = “hub_id” 
c. Input layer 2 = buffered Cores or hexagons, table field to join by = “hub_id” 
d. If applicable, select only the field “expbuf_mean” field to be joined to the non-buffered 

cores or hexagons. This will help keep a more manageable attribute table without 
duplicates. 

e. Save the resulting layer as “hubs_join.shp” (or equivalent “hex_join” feature class for 
the hexagonal grid. Note that the hexagonal grid will likely need to be stored in a file 
geodatabase or similar due to the large number of features) 

f. When complete, the non-buffered Cores or hexagons will contain the buffered 
Community Exposure Index scores in the field “expbuf_mean” 

U. Hub Score is the product of the Fish and Wildlife mean and the Community Exposure mean for 
each Habitat Core or hexagon. Calculate the score of each Habitat Core or hexagon for layer 
“hubs_join” 

a. Add field “hub_score” (or equivalent “hex_score” for the hexagonal grid) to layer 
“hubs_join” (float field type) in the attribute table 

b. Using the field calculator, populate the field “hub_score” by multiplying the fields 
“fw_mean” by “expbuf_mean” (fw_mean * expbuf_mean). The result is the score of 
each Habitat Core or hexagon 

c. Remove the Habitat Cores or hexagons that have a score of 0 or NULL 
V. Determine Hub Rank of layer “hubs_join” 

a. With layer “hubs_join,” add a field in the attribute table called “hub_rank” (integer field 
type) 

b. Using a quantile distribution, symbolize the values of field “hub_score” into 10 classes  
c. The first classification of score values (lowest values) will be Rank 1 hubs, whereas the 

last, or tenth classification of score values (highest), will be Rank 10 hubs Use the Field 
Calculator to apply a formula using the “case” and “when” expressions, or using Select 
By Attribute:   

i. Select by attribute the hubs that have a “hub_score” of the lowest, class 1 
distribution 

1.  Using the field calculator, and with class 1 hubs selected, calculate field 
“hub_rank” to a value of 1 

ii. Select by attribute the hubs that have a “hub_score” of the second-lowest, class 
2 distribution 

1.  Using the field calculator, and with class 2 hubs selected, calculate field 
“hub_rank” to a value of 2 

iii. Select by attribute the hubs that have a “hub_score” of the lowest, class 3 
distribution 

1.  Using the field calculator, and with class 3 hubs selected, calculate field 
“hub_rank” to a value of 3 

iv. Repeat this procedure until all 10 classes of “hub_score” have defined the 
values of “hub_rank” 
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v. The result is final ranked Resilience Hubs Cores 

W. Apply Hub Rank distribution to the hexagonal grid to attribute ranking 
a. Remove the hexagonal grid features that have a “hex_score” of 0 or NULL 
b. Add a field “hex_rank” in the attribute table (integer field type) 
c. Use the same 10-class distribution limits that were used to create Hub Ranks to 

attribute ranks (“hex_rank”) to the hexagonal grid (the upper and lower values will likely 
need to be extended to the minimum and maximum hexagonal grid values as hexagonal 
grid zonal statistics were applied at a smaller scale than Habitat Cores) 

d. The result is the final ranked Resilience Hub Grid 

Below is the distribution for the Alaska Resilience Hubs: Resilience Hub Cores and the finer-scale 
Resilience Hub Grid. The Resilience Hubs scores were classified into ten classes using a quantile 
distribution, and then reclassified into ten rank classes to allow readers to more easily distinguish 
values.  

Alaska Resilience Hubs Distribution 

Resilience
Hubs 
Score 
Break 
Value 

1 - 8.9 9 - 12.9 
13 - 
17.5 

17.6 - 
21.9 

22 - 
26.6 

26.7 - 
31.0 

31.1 - 
35.5 

35.6 - 
40.4 

40.5 - 
46.9 

46.7 - 
90.4 

Final Rank 
Value 

1 2 3 4 5 6 7 8 9 10 
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H. Stakeholder Engagement 

To allow local stakeholders to review and provide input on preliminary Assessment products, the Project 
Team hosted a virtual stakeholder workshop including a series of three meetings: one overview on 
October 5, and one each focused on fish and wildlife and community exposure on October 6, 2021. All 
invited stakeholders had access to written materials and an online GIS viewer to review draft models 
and provide comments during and after the workshop. The following list includes all organizations that 
were invited to participate in the stakeholder review process. 

Ahtna Intertribal Resource Commission 
Alaska Association of Environmental Professionals 
Alaska Beluga Whale Committee 
Alaska Conservation Foundation 
Alaska Department of Commerce, Community, and Economic Development, Division of Community and Regional 
Affairs 
Alaska Department of Fish and Game, Division of Habitat 
Alaska Department of Fish and Game, Division of Wildlife Conservation 
Alaska Department of Military and Veterans Affairs, Division of Homeland Security and Emergency Management 
Alaska Department of Natural Resources, Division of Geological & Geophysical Surveys 
Alaska Department of Natural Resources, Office of History and Archaeology 
Alaska Eskimo Whaling Commission 
Alaska Federation of Natives 
Alaska Geospatial Council 
Alaska Native Claims Settlement Act Regional Association 
Alaska Native Science Commission 
Alaska Native Tribal Health Consortium 
Alaska Ocean Observing System 
Alaska Sea Grant 
Alaska Sea Otter and Steller Sea Lion Commission 
Aleut Marine Mammal Commission 
Aleutian Pribilof Islands Association 
Aleutian Pribilof Islands Community Development Association 
Arctic Slope Native Association 
Association of Village Council of Presidents 
Audubon Alaska 
Bering Sea Elders Group 
Bristol Bay Borough Planning Department 
Bristol Bay Native Association 
Central Council of the Tlingit and Haida Indian Tribes of Alaska 
Chugachmiut 
Cook Inlet Tribal Council 
Cook Inletkeeper 
Copper River Native Association 
Denali Borough Planning Department 
Denali Commission 
Eskimo Walrus Commission 
Eyak Preservation Council 
Friends of Alaska National Wildlife Refuges 
Haines Borough Planning Department 
Indigenous People’s Council for Marine Mammals 
Inuit Circumpolar Council 
Inupiat Community of the Arctic Slope 
Juneau Borough Planning Department 
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Kawerak, Inc. 
Kenai Peninsula Borough Planning Department 
Kenai Watershed Forum 
Ketchikan Gateway Borough Planning Department 
Klawock Cooperative Association 
Kodiak Area Native Association 
Kodiak Island Borough Planning Department 
Maniilaq Association 
Matanuska-Susitna Borough Planning Department 
NOAA National Marine Fisheries Service 
NOAA National Weather Service 
NOAA Office for Coastal Management 
North Slope Borough Department of Wildlife Management 
Orutsararmiut Native Council 
Southeast Alaska Conservation Council 
Tanana Chiefs Conference 
The Alaska Center 
The Nature Conservancy Alaska 
Throwe Environmental 
U.S. Arctic Research Commission 
U.S. Army Corps of Engineers 
U.S. Bureau of Land Management 
U.S. Department of Agriculture 
U.S. Environmental Protection Agency 
U.S. Federal Emergency Management Agency 
U.S. Fish and Wildlife Service 
U.S. Forest Service 
U.S. Geological Survey 
U.S. National Park Service 
University of Alaska Anchorage, Alaska Center for Conservation Science 
Yakutat Borough Planning Department 


